## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Version</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/12/2017</td>
<td>3.6</td>
<td>Updated Modeled Capacity section screen shots for new ranges</td>
<td>Lydia Safko</td>
</tr>
<tr>
<td>02/27/2017</td>
<td>3.5</td>
<td>Reviewed for WEBP<em>1</em>11 updates - Updated “Access PCMM Web” section for SSOi requirements; added cross reference table for care type/roles in the “User Roles” section; added 508 Compliance section; added NOTE to page 13 and 14 that lock/unlock feature is now obsolete due to mandated SSOi login; updated User Requirements section on page 2, Step 1 for PIV exemption</td>
<td>Lydia Safko</td>
</tr>
<tr>
<td>02/14/2017</td>
<td>3.4</td>
<td>Added definition for Care Type and Focus</td>
<td>Lydia Safko</td>
</tr>
<tr>
<td>02/10/2017</td>
<td>3.3</td>
<td>Added Screenshot and Table Headings</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>02/01/2017</td>
<td>3.2</td>
<td>Updated for WEBP<em>1</em>6 page 28, Step 6 first bullet and WEBP<em>1</em>9 on page 94 added Step 3 under Search for VA Staff Update for WEBP<em>1</em>9 on page 17, Step 1 added third bullet and added Step 4; page 96 for WEBP<em>1</em>9, added second and third bullet.</td>
<td>Lydia Safko</td>
</tr>
<tr>
<td>11/9/2015</td>
<td>3.1</td>
<td>Added a Assigning Patients to a Primary HBPC Team section</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>9/1/2015</td>
<td>3.0</td>
<td>Rearranged topics.</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>08/31/2015</td>
<td>2.9</td>
<td>Updated the following section: PACT Panel Placement Assign a Surrogate Modify or View Surrogate Staff Assignments MPACT Request Process</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>05/05/2015</td>
<td>2.8</td>
<td>Adding Reports to User Guide</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>04/23/2015</td>
<td>2.7</td>
<td>Document Rewrite for new Release.</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>11/4/2014</td>
<td>2.6</td>
<td>Technical Edit. Several changes. Added Screenshots to steps. Updated per Sprint functionality.</td>
<td>Kate Hula</td>
</tr>
<tr>
<td>Date</td>
<td>Version</td>
<td>Notes</td>
<td>Author</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>7/9/2014</td>
<td>2.5</td>
<td>Document Rewrite for new Release</td>
<td>Tracy Hunt</td>
</tr>
<tr>
<td>1/14/2013</td>
<td>2.4</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>12/11/2012</td>
<td>2.3</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>11/19/2012</td>
<td>2.2</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>10/23/2012</td>
<td>2.1</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>9/25/2012</td>
<td>2.0</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>8/24/2012</td>
<td>1.9</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>7/31/2012</td>
<td>1.8</td>
<td>Updated per Sprint functionality</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>6/29/2012</td>
<td>1.7</td>
<td>Added Rooms Management section</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>6/5/2012</td>
<td>1.6</td>
<td>Added CDW changes, Non-VA Provider information, and Team Model Configuration</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>5/8/2012</td>
<td>1.5</td>
<td>Added alerts section</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>4/6/2012</td>
<td>1.4</td>
<td>Added information to Assign Staff to a Position and Active Panel Report sections</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>3/9/2012</td>
<td>1.3</td>
<td>Added sections Multiple PCP Assignments and Unassign Patient from team</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>2/13/2012</td>
<td>1.2</td>
<td>Included sections on Reports, Search for Patient/Team, View Patient Profile, Assign Patient to Team,</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>1/13/2012</td>
<td>1.1</td>
<td>Made changes indicated by reviewers</td>
<td>Brian Lynch</td>
</tr>
<tr>
<td>1/9/2012</td>
<td>1.0</td>
<td>Initial Document</td>
<td>Brian Lynch</td>
</tr>
</tbody>
</table>
# Table of Contents

**GETTING STARTED** .................................................................................................................. 1  
PCMM Web Overview .................................................................................................................. 1  
System Requirements .................................................................................................................. 2  
User Requirements .................................................................................................................... 2  
Access PCMM Web ..................................................................................................................... 2  
Select/Change Station .................................................................................................................. 7  
PCMM Web Home Page ............................................................................................................... 8  
PCMM Web Icons ....................................................................................................................... 11  
Log Out of PCMM Web ................................................................................................................ 12  
Automatic Timeout ..................................................................................................................... 12  
Help With Error Messages .......................................................................................................... 12  
User Management ...................................................................................................................... 13  

**TEAM MANAGEMENT** ........................................................................................................... 15  
Create a Team Profile ................................................................................................................ 15  
Create a Team Role (Position) Profile ....................................................................................... 18  
Assign Staff to a Team Role (Position) ..................................................................................... 20  
Preceptor/Preceptee Relationships .......................................................................................... 24  
Assigning a Preceptor/Preceptee .............................................................................................. 25  
Modify or View a Team Profile .................................................................................................. 28  
Modify or View a Team Role (Position) ................................................................................... 32  
View or Modify Team Role (Position) History ......................................................................... 36  
View Team Role (Position) Attribute Change History .............................................................. 40
<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Team Attributes Change History</td>
<td>41</td>
</tr>
<tr>
<td>Validate Team Data Consistency</td>
<td>43</td>
</tr>
<tr>
<td>Search for a Team by Name</td>
<td>44</td>
</tr>
<tr>
<td>Assign a Surrogate</td>
<td>46</td>
</tr>
<tr>
<td>Modify or View Surrogate Staff Assignments</td>
<td>50</td>
</tr>
<tr>
<td>Reconcile Team with Models</td>
<td>52</td>
</tr>
<tr>
<td>Maintain a Team Model Configuration</td>
<td>53</td>
</tr>
<tr>
<td>Create a Role for a Team Model Configuration</td>
<td>54</td>
</tr>
<tr>
<td>Calculate Model Panel Size – Selection of Care Type</td>
<td>55</td>
</tr>
<tr>
<td>Calculate Model Panel Size - Primary Care Worksheet</td>
<td>55</td>
</tr>
<tr>
<td>Calculate Model Panel Size - Adjust Capacity</td>
<td>58</td>
</tr>
<tr>
<td>Update Primary Care Intensity</td>
<td>59</td>
</tr>
<tr>
<td>PATIENT MANAGEMENT</td>
<td>60</td>
</tr>
<tr>
<td>Assign a Patient to a Team</td>
<td>60</td>
</tr>
<tr>
<td>Search for a Patient</td>
<td>63</td>
</tr>
<tr>
<td>View or Modify a Patient Profile</td>
<td>65</td>
</tr>
<tr>
<td>Assign Patient to a PACT Team</td>
<td>67</td>
</tr>
<tr>
<td>Unassign a Patient from a Team</td>
<td>68</td>
</tr>
<tr>
<td>Reassign a Patient to Team Role (Position)</td>
<td>70</td>
</tr>
<tr>
<td>Reassign a Patient to a Team</td>
<td>71</td>
</tr>
<tr>
<td>Mass Reassign/Unassign Patients</td>
<td>74</td>
</tr>
<tr>
<td>Auto Inactivation of a Patient from a Team</td>
<td>80</td>
</tr>
<tr>
<td>Manually Inactivate a Patient from a Team</td>
<td>81</td>
</tr>
</tbody>
</table>
Multiple PACT Requests for Patient ................................................................. 84
MPACT Request Process ................................................................................. 86
Assign a Non-VA Provider to Patient ............................................................ 94
PACT Panel Placement .................................................................................... 96

STAFF MANAGEMENT .................................................................................. 98
Search for VA Staff .......................................................................................... 98
Remove or Unassign Staff from a Team Role (Position) ................................. 100
Reassign or Modify Staff Assignment .............................................................. 103
Create a Non-VA Provider .............................................................................. 105
Search for a Non-VA Provider ........................................................................ 107
Modify an Existing Non-VA Provider ............................................................. 108
Create a New Non-VA Practice ...................................................................... 110
Update an Existing Non-VA Practice ............................................................... 112

ROOMS MANAGEMENT ............................................................................... 113
Create a Room .................................................................................................. 113
Manage Rooms ................................................................................................ 114
Search for a Room ............................................................................................ 115
Modify an Existing Room ............................................................................... 116
Assign a Room to a Team ............................................................................... 117
View Room Assignments for a Team ............................................................... 120

GROUP MANAGEMENT ............................................................................... 121
Create a New Group ......................................................................................... 121
View Groups List ............................................................................................... 122
# Table of Contents - Figures

| Figure 1 - Single Sign-On with PIV Card                                      | 3    |
| Figure 2 - Selecting a PIV Certificate                                      | 3    |
| Figure 3 - Certificate Details                                               | 4    |
| Figure 4 - Entering PIV Pin in ActivClient Box                              | 4    |
| Figure 5 - Signing in Using VA Network ID and Password                      | 5    |
| Figure 6 - Signing in with VA Network ID                                     | 5    |
| Figure 7 - Enter VA Network ID and Password                                  | 6    |
| Figure 8 - Signing In with Windows Authentication                           | 6    |
| Figure 9 - Signing In with Windows Authentication                           | 7    |
| Figure 10 - Select/Change Station Screen                                    | 8    |
| Figure 11 - Station/User Menu Bar                                           | 8    |
| Figure 12 - PCMM Web Menu Bar                                               | 9    |
| Figure 13 - Breadcrumbs                                                     | 9    |
| Figure 14 - Help Icon and Help Menu Item                                    | 9    |
| Figure 15 - Contents Area Screen                                            | 9    |
| Figure 16 - Alerts Box                                                      | 10   |
| Figure 17 - Footer Screen                                                   | 10   |
| Figure 18 - Log Out Link                                                    | 12   |
| Figure 19 - Select/Change Station Screen                                    | 13   |
| Figure 20 - Available Stations Screen                                       | 14   |
| Figure 21 - Inactivating a User Screen                                      | 15   |
| Figure 22 - Create a Team Menu Option Screen                                | 15   |
| Figure 23 - Create a New Team Screen                                        | 16   |
| Figure 24 - Modify an Existing Team                                         | 17   |
| Figure 25 - View Positions & Staff Link Selected                            | 18   |
| Figure 26 - Position List Screen with the Create a Position Button Selected | 19   |
| Figure 27 - Create a New Position Screen                                    | 20   |
| Figure 28 - View Position & Staff Link Selected to Assign Staff             | 20   |
| Figure 29 - Assign Staff to a Position Screen                               | 21   |
| Figure 30 - Search for Staff Role                                           | 21   |
| Figure 31 - Staff Information Screen                                        | 22   |
| Figure 32 - Position List Screen with the Action Icon Selected               | 23   |
| Figure 33 - Modify an Existing Position Screen with the Assign Staff Button Selected | 23   |
| Figure 34 - Search for a Staff box with Staff Information Selected          | 23   |
| Figure 35 - Modify an Existing Position Screen with the Manage Preceptor Button Selected | 26   |
| Figure 36 - Create/Edit Preception Assignment Screen                        | 26   |
| Figure 37 - Preceptor Assignment Timeline with Actions Icons Selected       | 28   |
| Figure 38 - List All Teams Menu Option                                      | 28   |
| Figure 39 - Create A Team Screen with a Name Selected                       | 29   |
| Figure 40 - Modify an Existing Team Screen                                  | 30   |
| Figure 41 - Status Change Timeline Screen                                   | 31   |
| Figure 42 - Update Entry Box                                                | 31   |
| Figure 43 - Status Change Timeline Screen with the Add Entry Button Selected | 31   |
| Figure 44 - Add Entry Box Defined and Submit Button Selected                | 31   |
| Figure 45 - Positions & Staff Assignments Link Selected to View a Team Role | 32   |
| Figure 46 - Position List with the Actions Icon Selected                    | 33   |
| Figure 47 - Modify an Existing Screen                                       | 36   |
| Figure 48 - List All Teams Menu Option                                      | 36   |
| Figure 49 - Create a Team Screen with the Positions Icon Selected           | 36   |
| Figure 50 - Search for Team Menu Option                                      | 37   |
Figure 102 - Attention Message After a Patient is Assigned to a Team ........................................... 62
Figure 103 - Search for a Patient Menu Option ................................................................. 64
Figure 104 - Search for a Patient Screen ........................................................................ 64
Figure 105 - Search for Patient Menu Option to View or Modify a Patient Profile .............. 65
Figure 106 - Search for Patient Screen to View or Modify a Patient Profile ....................... 65
Figure 107 - Search for Patient Screen with the Patient Name Selected ................................. 66
Figure 108 - View or Modify the Patient Profile Screen ....................................................... 66
Figure 109 - Search for Team to Assign a Patient to a PACT Team .................................. 67
Figure 110 - Patient Assigned to a Team Attention Box .................................................... 67
Figure 111 - Unassing a Patient from a Team from the Patient Profile Screen ..................... 69
Figure 112 - Unassignment Confirmation Message ............................................................. 69
Figure 113 - Team Unassignment Box .............................................................................. 69
Figure 114 - Reassign a Patient from the View Team Assignment Section ....................... 71
Figure 115 - Revert Assignment to Active Box ................................................................... 72
Figure 116 - Assigned Patient on the View Team Assignments Section .............................. 72
Figure 117 - Reassign a Patient to PC Team on the View Team Assignments Section ........ 73
Figure 118 - Reassignment Confirmation Message ............................................................ 73
Figure 119 - Reassign Patient to PACT Team on View Team Assignments Section .......... 73
Figure 120 - Assigned Team Displays as Active .................................................................. 74
Figure 121 - Mass Reassign on the Team Profile Screen .................................................... 75
Figure 122 - Mass Reassign on the Launch Batch Operations on Patients Screen .............. 75
Figure 123 - Confirmation Message for the Mass Reassignment ........................................ 76
Figure 124 - Entire Time Link Selected on the Search for Team Box .................................. 76
Figure 125 - Patient Batch Transfer/Assign Box ................................................................. 76
Figure 126 - Unassign Patients from the Team Profile Screen ........................................... 78
Figure 127 - Unassign from the Launch Batch Operations Patients Screen ....................... 78
Figure 128 - Unassign Confirmation Message ................................................................... 79
Figure 129 - Unassign Selected Patients Box ...................................................................... 79
Figure 130 - Patient has been Identified for Auto Inactivation ............................................ 80
Figure 131 - Manually Inactive a Patient from a Team ...................................................... 81
Figure 132 - View Patient Assignments Section with the Green Plus Icon Selected ........... 82
Figure 133 - Extend Patient Team Assignment Auto Inactivate Box ................................. 82
Figure 134 - Manually Inactive a Patient by Selecting the Green Plus Icon ....................... 82
Figure 135 - Extend Patient Team Assignment Auto Inactivate Box ................................. 83
Figure 136 - Manually Inactivate a Patient from the Position Profile Screen ..................... 83
Figure 137 - Manually Inactive a Patient by Selecting the Green Plus Icon ....................... 84
Figure 138 - Warning: Multiple PACT Automatic Creation Message ............................... 86
Figure 139 - Multiple PACT Request section on the Patient Profile Screen ..................... 87
Figure 140 - A MPACT Request for a Patient Alert ............................................................ 87
Figure 141 - Create or Edit Multiple PACT Request Screen .............................................. 89
Figure 142 - Your Multiple PACT Request was Saved Successfully Attention Message .... 90
Figure 143 - Multiple Pact Approval Alert ......................................................................... 91
Figure 144 - Multiple Pact Requests with a Pending Status ................................................ 91
Figure 145 - Approving a MPACT on the Required Pact Approvals Section ...................... 91
Figure 146 - View Non-VA Providers Screen with the Assign Button Selected .................. 94
Figure 147 - Assign a Non-VA Provider to a Patient Screen Searching for a Provider .... 95
Figure 148 - Search for Non-VA Provider Screen ............................................................ 95
Figure 149 - Submitting the Patient Assignment to the Non-VA Provider ......................... 96
Figure 150 - View Panel Placements Request with the Create a Request Button Selected ... 97
Figure 151 - Create Panel Placement Request Screen ....................................................... 97
Figure 152 - Edit a Request from the View Panel Placement Requests Section ................... 98
Figure 153 - Search for VA Staff Menu Option Selected to Manage VA Staff ................... 98
Figure 154 - Search for Staff Box to Manage VA Staff ...................................................... 99
Table of Contents - Tables

Table 1 - PCMM Web Icons ................................................................. 11
Table 2 - Preceptor/Preceptee Relationships ..................................... 24
Table 3 - User Roles, Descriptions, and Permissions ............................ 146
Table 4 - Detailed Role Table ............................................................. 148
Table 5 - Detailed Care Type Table .................................................... 150
GETTING STARTED

PCMM Web Overview

The Patient Centered Management Module (PCMM) Web application assists VA facilities in implementing and monitoring patient and staff assignments in both primary care and non-primary care teams. PCMM Web is a web browser, user interface integrated through the Clinical Information Support System (CISS) portal.

The newly developed Primary Care (PC) system balances productivity with quality, access, and patient service. In a PC setting and in the Patient-Aligned Care Team (PACT) model, patients are assigned a Primary Care Provider (PCP) who is responsible for delivering essential health care, coordinating all health care services, and serving as the point of access for VA care. A team is formed based on specific care type (i.e., Primary Care, Mental Health) and aligned around a patient, including providers across multiple VA sites and in non-VA settings for efficient care coordination and communication. The PCP works together with a team of professionals which includes nurses, pharmacists, social workers, health care professions, trainees, clerks, and more. Additionally, teams can be grouped together for a larger collaborative team.

Within PCMM Web, users can establish and define a healthcare team, assign staff and health professions trainees to positions within the team, assign patients to the team, and assign patients to practitioners, including trainees. A patient can be assigned to multiple PACT teams. Those assignments are tracked across VA stations through Multiple PACT requests, which require an approval or a denial from all involved stations. Multiple assignment requests for the same patient for different stations are allowed, but there can only be one active assignment per patient, per station at a time.

When PCMM data is entered in a standardized manner, it can be used to analyze the system and PACT workload nationally by Veterans Integrated Service Network (VISN), and by a facility and its substations, as well as at the team level. PACTs manage the overall care provided to a majority of VA health care systems, and their workload capacity is an important factor in determining the total number of patients that can be cared for in the system.

For additional PCMM Web documentation, refer to the VA Software Document Library (VDL) Web site.

http://www.va.gov/vdl/

Note: The National Service Desk (NSD), also known as the Helpline, will provide support for PCMM Web technical support following deployment. Contact the NSD with 1-855-NSD HELP or 1-855-673-4357.
System Requirements

The following are system requirements for utilizing the Patient Centered Management Module (PCMM) Web application:

- Access to the Veterans Health Administration (VHA) Intranet via Microsoft Internet Explorer.

User Requirements

1. Users are required to login using a PIV Card unless the user has a PIV exemption to login with network credentials.
2. Required “Divisions” are assigned in PCMM Web by the Principal Facility Coordinator, Principal MH Coordinator or VISN/National PCMM Staff using PCMM Webs User Management functionality via the User Admin button.
3. Required “Divisions” are assigned to their Vista Profile by local/regional IT staff or ADPAC. These divisions should at a minimum match what is assigned to the user in PCMM Web. (Example: If user has division 123, 123AB, 123AC and 123AD assigned in PCMM Web, they should also have these stations assigned in VistA.)
4. The “SCMC PCMMR WEB USER MENU” will need to be assigned as a secondary menu option in Vista.

Access PCMM Web

Users can access PCMM Web using a web browser via single sign-on capabilities. Single Sign-On Internal (SSOi) is an authentication service provided by Identity Access Management (IAM) and designated for operations-based applications such as PCMM Web. This service provides an extra layer of security when accessing the application, while reducing time associated with multiple logon/logoff activities. A PIV card is required, unless an exception to use VA User Credentials is allowed.

- Upon successful login, the user is directed to the Select/Change Facility Screen or to the PCMM Web Home Page. If a user is assigned to multiple facilities and has not yet selected a default facility, the user must select the appropriate facility before proceeding.
- Refer to Select/Change Facility section for additional information. If a user is only assigned to one facility, the PCMM Web Home Page displays for that facility. Once a user has selected the default facility, the PCMM Web Home Page displays it. The system then uses this Facility in all subsequent functions.

SSOi with PIV

1. Ensure your PIV card is inserted in the card reader.
2. Using the web browser, access PCMM Web through URL: https://vaww-pcmm.cc.med.va.gov/ciss
3. The VA Single Sign-On Screen displays. Click Sign In with VA PIV Card.
   - If the VA Single Sign-On Screen is not displaying using Internet Explorer, ensure SSL 2.0 and SSL 3.0 are unselected in the browser security settings.
In your browser's top right corner, click the **Tools** icon and select **Internet Options**. Click the **Advance** tab and ensure the options are unselected.

**Figure 1 - Single Sign-On with PIV Card**

![Image of Single Sign-On with PIV Card]

4. The system will verify and read the PIV card. If found, the **Windows Security** box displays with the list of certificates associated with the PIV card.

5. Select the **certificate** and click **OK** to display the **ActivClient Login** window.

**Figure 2 - Selecting a PIV Certificate**

![Image of Selecting a PIV Certificate]

- If more than one certificate displays, select **Click here to view certificate properties** link to display the **Certificate Details** box. Select the Certificate Path tab and scroll to ensure the certificate ends in **internal PIV Authentication**.
6. Enter your **Pin Number** and click **OK**.

**Figure 4 - Entering PIV Pin in ActivClient Box**

7. Once the system verifies the PIV card and Pin Number match, the **Select/Change Facility Screen** displays or the **PCMM Web Home Page**.
   - If the user is *only* authorized to a single facility, the system defaults to the authorized facility. The user does not have to select it upon login. The System recognizes this access and uses the selected facility in all subsequent functions.
   - If the user is authorized to access multiple facilities:
     - If the user has previously selected a default facility, the user does not have to select a facility upon login. The system defaults to the specified default facility and uses this facility in all subsequent
functions. To change the facility, click the **Facility name link** in the header bar to display the **Select/Change Facility** page.

### Using VA Network ID and Password

In some cases, a user may sign-in with their **VA Network Username** and **Password**. This is only to be utilized when a PIV exemption is required. User must call VA Help Desk and request this exemption for this option to be utilized.

8. On the **VA Single Sign-On Screen**, click the **View Other Sign-On Options** link to display the **VA Single Sign-On box**.

**Figure 5 - Signing in Using VA Network ID and Password**

9. Click **Sign in with VA Network ID**.

**Figure 6 - Signing In with VA Network ID**
10. The **VA Single Sign-On** box displays text fields to enter your **VA Network ID** and **Password**. Click **Sign-In**.

   **Figure 7 - Enter VA Network ID and Password**

   ![VA Single Sign-On](image)

11. The system will verify the user and be redirected to the **Select/Change Facility Screen** or the **PCMM Web Home Page**.

**Windows Authentication**

12. On the **VA Single Sign-On Screen**, click the **View Other Sign-On Options** link to display the **VA Single Sign-On** box.

   **Figure 8 - Signing In with Windows Authentication**

   ![VA Single Sign-On](image)
13. Click **Sign in with Windows Authentication**.

![Figure 9 - Signing In with Windows Authentication](image)

14. The system will verify the user and be redirected to the **Select/Change Facility Screen** or the **PCMM Web Home Page**.

**Notes:**

- For first time logins after the PCMM Web upgrade from PCMM Legacy, a user may be prompted to set the time zone, if the system clock has changed time zones. This is usually a one-time occurrence.
- Ensure each PCMM Web user has VistA privileges for the station(s) they have access to in PCMM Web.
- If a user requires access to more than the 3-digit parent site, the user must also have access set up in VistA for that facility. For example, if a user requires access to site 123abc, the user's new person file must contain that site. If a user only has access for site 123 in VistA, they will only be able to search for patients associated with that site. If the user needs to have access to patients at site 123a and 123ag, the new person file in Vista should have the subdivisions added.

**Select/Change Station**

If a user is authorized to work at multiple stations, the **Select/Change Station** screen displays after login with a list of authorized stations. If a user is assigned to only one station, the Patient-Centered Management Module home page displays instead; skip the Select/Change Station section of this guide and refer to the PCMM Web section below for further details.

1. On the **Select/Change Station** screen, select the appropriate station in the **Select a Station** list to access PCMM Web and click **Submit**.

   **Note:** For an easier selection, the last station accessed is highlighted in the Select a Station list.
2. To filter through the list, enter the three digit station code in the Select Station text box and click Submit. The Patient-Centered Management Module screen will display.

**Figure 10 - Select/Change Station Screen**

![Select/Change Station Screen](image)

**PCMM Web Home Page**

After entering VA credentials and the appropriate station is selected (if prompted), the Patient-Centered Management Module home page displays.

To navigate to the Patient-Centered Management Module home page at any time, click the PCMM button in the upper right corner. If a user has access to User Management functionality, the PCMM button and the User Admin button are displayed.

The user name is displayed in the top right corner of the application header. The station name and number is displayed in the top left hand corner. The VISN is displayed below the station information.

**Figure 11 - Station/User Menu Bar**

![Station/User Menu Bar](image)

If a user is only authorized to work at a single station, the system will default to that station and the station name along with its parent VISN is displayed. A user will only have access to the data for the station(s) that they are assigned to in PCMM Web.

**The Menu Bar**

The menus across the top of the screen allow access to functions that a user can perform, according to role assigned to the user.
Figure 12 - PCMM Web Menu Bar

The Bread Crumb Trail

As a user navigates through the application, the names of screens will appear at the top left of the screen to show your location in the application. A user can click the screen names to go to that location.

Figure 13 - Breadcrumbs

The Help Button

Clicking the blue Help button on each screen will display help that is specific to that screen. To access the Table of Contents for the entire help file, click Help > Web Help from the main menu. There is also a bread crumb trail at the top of the window that shows the location of the current help topic in the larger help file.

Figure 14 - Help Icon and Help Menu Item

The Content Area

This section of the window has explanatory text, and where all input, viewing, and PCMM Web tasks are performed.

Figure 15 - Contents Area Screen

The Announcements Box
Any important program announcements will display in the Announcements box.

**The Alerts Box**

Any pending alerts will display in the Alerts box. Select the **click here** link to view the Alert Summary page.

![Figure 16 - Alerts Box](image)

**The Footer**

This area at the bottom of every application screen contains:

- PCMM Audit Warning
- Contact information for questions or problems,
- the application version and
- the copyright date

![Figure 17 - Footer Screen](image)
PCMM Web Icons

The following table describes the icons used in the PCMM Web.

Table 1 - PCMM Web Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Page Location Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open file icon" /></td>
<td>Open file</td>
<td>Completed Reports List</td>
</tr>
<tr>
<td><img src="image" alt="Save As icon" /></td>
<td>Save As</td>
<td>Completed Reports List</td>
</tr>
<tr>
<td><img src="image" alt="Run a Report icon" /></td>
<td>Run a Report</td>
<td>Reports List</td>
</tr>
</tbody>
</table>
| ![Permanently Delete Report icon](image) | Permanently Delete Report | • Position List  
• Group Lists  
• Completed Report List |
| ![View Team Roles icon](image) | View Team Roles | Team List |
| ![Reassign/Add icon](image) | Reassign/Add | • Team Profile  
The green icon is used to select an auto inactivation date for a team assignment. |
| ![Edit/View Information icon](image) | Edit/View Information | • Patient Profile  
• Position List  
• Modify an Existing Position  
• Open Alerts List |
| ![Unassign/Remove icon](image) | Unassign/Remove | • Patient Profile  
• Modify an Existing Group  
• Open Alerts List |
| ![View list of alerts icon](image) | View list of alerts | Alerts Summary |
| ![Add a Comment icon](image) | Add a Comment | Open Alerts List |
| ![View selected item icon](image) | View selected item | Model Panel Size Calculation |
| ![View information icon](image) | View information | The information button icon is used when information on a page cannot be edited, but can only be viewed. |
| ![Edit icon](image) | Edit | The edit icon is used when information on the page can be edited. |
| ![View Patient Inactivation icon](image) | View Patient Inactivation | The Scheduled Inactivation Date is between 91 - 120 days |
| ![View Patient Inactivation icon](image) | View Patient Inactivation | The Scheduled Inactivation Date is |
The Scheduled Inactivation Date is between 31 - 60 days

The Scheduled Inactivation Date is between 1 - 30 days

Email staff member if an email address is associated with the record.

Select an item

- Search for a Group
- Search for Room
- Search for a Staff Team
- Reassignment

Edit a Preceptee assigned

### Log Out of PCMM Web

1. Click the **Log Out** link on the top right side of the screen.

   ![Figure 18 - Log Out Link](image)

   2. A confirmation message is displayed. Click **OK** to confirm or **Cancel** to remain in the system.

   **Note:** The system will log a user out if no system activity for 15 minutes.

### Automatic Timeout

The system automatically logs a user out after 15 minutes of inactivity. A warning message displays, counting down from 60 seconds until a user is logged off the application.

A user may click the **OK** button to stop the count-down and continue working. If the system automatically logs off, the current work in PCMM Web is not saved.

### Help With Error Messages

If the application displays an error at the time log on or if error messages that is NOT part of data entry (e.g., a system error message), contact the VA Service Desk to log a Remedy ticket:

- Call 1-888-596-4357
• Email VASD@va.gov

With the appropriate access, a user may log a Remedy ticket and capture a screenshot of the error, to be placed with the ticket.

User Management

If a user has the User Management role assigned, the user has access to the User Management functionality and the User Admin button displays when logging into PCMM Web. The authorized user can click the User Management button to setup a user in PCMM Web.

Granting Access to PCMM Web

1. On the CISS home screen, click the User Admin button in the upper right corner to display the User Management screen.

   **Figure 19 - Select/Change Station Screen**

2. The Search for Existing Users to Manager screen may display or click Users from the Main Menu and then Manage an Existing User to display the Search for Existing Users to Manager screen.

3. The authorized user can search for new or existing users. The system will search first within PCMM Web to see if the user is already established. If not, the system will then search using LDAP for a new user. The following are search options:
   - Select the Based on User ID radio button to search for a user by the VHA Network ID. This is the default search parameter.
   - Select the Using the full Last Name OR Using a part of the First Name and the full Last Name radio button to search by the name criteria. The last name is required for this search. If the system gets an exact match, the user will be presented with the previously established data. If there is more than one user, the user will be presented with a user results list to select the appropriate user.

4. After the user is selected, click Submit to display the User Details screen.

5. The User Details screen enables an authorized user to manage each user’s access into PCMM Web. The authorized user will perform the following on this page:
   - Assign Role(s)
   - Search for Station(s)
   - Assign Station(s)
   - View Other Assigned Stations
   - Unlock a User (NOTE: This feature is obsolete with PIV sign-on)
   - Inactivate a User with a reason
   - Establish a Time Zone
   - View Application Permissions
Assigning Roles to a User

6. Assign the appropriate role(s) to each user. This determines the actions the user will be allowed to perform within PCMM Web.
   - **Available Roles** – From this list of **Available Roles**, the authorized user will assign the appropriate Role(s) for each user and a user can have 1 or more roles assigned to perform assigned tasks.
   - **Assigned Roles** – This displays all roles the user has been assigned.
   - The authorized user will be allowed to move a selected role from the **Available Roles** section to the **Assigned Roles** section for the new/existing user by:
     o By selecting a role and moving a role with the mouse cursor from one area to the other.
     o Double-click a role from one area to the other.
     o Click the double green arrow (Assign ALL or Unassign ALL) which moves ALL roles from one area to the other.
   - Each user MUST have at least 1 Role assigned.

Assigning Stations to a User

7. In the **Available Stations** text box, enter a station number and the system will display the parent station as well as all substations. Click the green arrow to assign/unassign all of the listed stations. Or, move individual stations from one area to the other.

   **Figure 20 - Available Stations Screen**

Unlocking a User

8. If the **Locked** check box is selected, the user has three unsuccessful login attempts and is unable to log into the CISS system for one hour. The “Lock” will clear automatically after the user has been locked out for one hour or an authorized user can unselect the **Locked** check box to unlock the user.
   (NOTE: This feature is now obsolete with PIV sign-on as the user will no longer be locked out after 3 unsuccessful attempts to log in using the VHA network IDs.)

Inactivating a User

9. Select the **Inactivate** check box to inactivate a user from PCMM Web. All users are setup initially as **Active** but can be changed by selecting the **Inactivate** check box.
   - If the check box is selected, the user is unable to log into the PCMM Web system and an error message is displayed, indicating the user is Inactivated and unable to log in.
10. Select the calendar icon in the **Inactivation Date** field to inactivate a user by a specific date. The date should not be prior to the date new the user information is created. This option is not available when creating a new user.
   - The Inactivation Date for an existing user can be established for a future or past date but cannot be before the user is created as a PCMM Web user. This field is not shown unless the Activation Indicator is selected.

11. Select the reason for a user to become inactive from the **Inactivation Reason** drop-down list. This feature is not available when creating a new user.

![Figure 21 - Inactivating a User Screen](image)

**Assigning a Time Zone**

12. Select a time zone in the **Time Zone** drop-down list. This area allows the user to set the time zone preference from a list of time zones.

**Viewing Application Permissions:**

1. Expand the **View Application Permissions** toggle link to display a list of the user’s roles and permissions.
   - The **Assigned** column indicates which roles and permissions are assigned to the user by either, Yes or a No.

**TEAM MANAGEMENT**

Teams consistent of staff members organized by care type (i.e., Primary Care, Mental Health) and aligned around a patient, including providers across multiple VA sites and in non-VA settings for efficient care coordination and communication.

**Create a Team Profile**

A user can create a new team using the Create a Team Profile screen.

1. From the Team drop-down menu, select **Create a Team**. Alternatively, click the **Create a Team** button at the top of the **Teams List** screen (**Teams > List All Teams**). The **Create a New Team** screen will display.

![Figure 22 - Create a Team Menu Option Screen](image)
2. Enter a name for the new team (required) in the Team text box. Team names must be between 3 and 30 characters. If the team name already exists for the site, an error message will appear. Teams do not span multiple sites.

3. Select the station the team is associated with from the Station drop-down list.

4. Select the specific team care type from the Care Type drop-down list. The care type available are:
   - Primary Care
   - Primary Care - HBPC
   - Case Management
   - Community Care
   - InPatient SCI
   - Mental Health
   - NON-PC Specialty (MED/SURG)
   - NON-VA Care

5. The Primary Care type requires a Focus and an optional second Focus. Select a choice from the Focus 1 drop-down list. Select another choice from the Focus 2 drop-down list, if applicable. **Note:** Focus 2 cannot be the same value as Focus 1.

6. Case Management, Mental Health, Community Care, and NON-PC Specialty (MED/SURG) have an option for a Focus. Select a choice from the Focus drop-down list. Primary Care – HBPC does not require a focus.

7. Enter a Description, if desired.

**Patient Capacity section:**

8. Ensure the Assignment Status (Open) radio button is selected.

**Status Setup section:**

9. The Select Status drop-down defaults to Active. If needed, select Inactive to make the team inactive.

10. The Effective Date for Status Change drop-down defaults to the current date and time. Click the Calendar icon to change the effective date.

11. The Select Status Change Reason drop-down defaults to New Team.

12. These Status Setup fields may be edited on the Create a New Team screen when a team is created. The activation date and reason are captured in Team History.

13. Click Submit, or Cancel to exit.

This screenshot is an example of a Primary Care Team. For other Care Types, the options and fields in the Patient Capacity section will vary.

**Figure 23 - Create a New Team Screen**
14. Once the team is created, the *Modify an Existing Team* screen displays with a message indicating the team was created successfully. Some team roles may be added due to the automatic model selection. If this confirmation text is not present, the setup was not completed correctly.

**Figure 24 - Modify an Existing Team**
Point of Contact – Administrative section
Displays the administrator staff member, including a phone number and email address, assigned to the team. POC is assigned at the Team Role (Positions) level. This section displays once Team Roles are established.

Point of Contact – Clinical section
Displays the point of contact staff member, including phone number and email address, assigned to the team. The POC is assigned at the Team Role (Positions) level. This section displays once Team Roles are established.

Non-Primary Care Teams:
- The Aggregated Modeled Team Capacity calculations will not be applied to Non-Primary Care teams and therefore, will not be displayed in the Patient Capacity section.
- If the team created is NOT a Primary Care Team, a user can manually enter a panel size on the View/Adjusted Modeled Capacity screen. This number will display in the Patient Capacity section as the Team Capacity.

Create a Team Role (Position) Profile
When a new team is created using the team type of Primary Care, the team roles of Primary Care Provider, Care Manager, Clinical Associate and Administrative Associate and their Surrogate roles will auto-populate. When creating specific team profiles (i.e., Mental Health), certain team role (positions) are created according to the automatic model selection chosen. A user must set up team roles that will act as preceptors prior to setting up Associate Providers (preceptees).

1. Locate the team to add a team role.
2. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.

3. Click the Create a Position button to display the Create a Position screen.
   - The team must have a status of Active.
General Section
4. Select a role (e.g., PACT Clinical Pharmacist, Associate Provider, and Social Worker) from the **Team Role** drop-down list. A Team Role may be established more than once within the team. The *Description* may be used to differentiate between two identical roles.
   - For a team with a Focus of Primary Care, there may only be one teamlet role of *Primary Care Provider, Care Manager, Clinical Associate,* and Administrative Associates for each PACT. See the Preceptor/Preceptee Relationships section for more information.
   - Additional Team Roles may be established more than once within the team.
5. Enter a description of the team role in *Description* text box. The maximum length is 250 characters.
6. Enter the FTE number the team role would be expect to provide for in the *Expected FTE* field. It must be greater than 0.00 and it cannot be greater than 1.00.

Status Setup Section
7. Change the status if desired using the **Select Status** drop-down list (*Active* is selected by default).
8. Select the calendar icon next to the **Effective Date for Status Change** field to select the date and time the team role will be effective. (Present date and time is shown by default). The date cannot be prior to the team’s creation date.
9. Select a reason for creating the team role from the **Select Status Change Reason** the drop-down list (*New Team Position* is selected by default).

Team Placement Section
10. Select the **Team Lead** check box to make a team role the team lead. There may only be one active Team Lead per team.
11. Select the **Point of Contact - Administrative** check box to make a team role the primary point of contact for the team. There may only be one active primary point of contact per team.
12. Select the **Point of Contact - Clinical** check box to make the team role the secondary point of contact for the team. There may be multiple secondary points of contacts.
Patient Capacity Section

13. The **Position Capacity** number is the allowed patient capacity for the calculate team model.

14. For Specific Team Roles Only According to Team Care Type. To override the allowed patient capacity number, select the **Allow Position Capacity Override** check box.

15. For Specific Team Roles Only According to Team Care Type. Enter the number of patients that will be allowed to be assigned to the team in the **Position Capacity Override** text box.

16. For Specific Team Roles Only According to Team Care Type. If desired, enter a justification for the override in the **Justification** text box.

17. Click the **Submit** button to save the information to the database.

18. Click the **View/Edit the Notification Distribution Rules** link to view a list of notification types and settings for the team.

**Figure 27 - Create a New Position Screen**

---

Assign Staff to a Team Role (Position)

To assign staff to a team role:

**From the Position List screen:**

1. From the Modify an Existing Team page, click the **View Positions and Staff Assignments** link. The Position List screen will display.

**Figure 28 - View Position & Staff Link Selected to Assign Staff**
2. Click a **NotAssigned** link in the Staff Name column to display the **Assign Staff to a Position** screen. The team role must be active.

**Figure 29 - Assign Staff to a Position Screen**

3. Enter the first two letters of a staff member's name, select a **Staff Role** and click **Search**. If no staff member is found, click the **Search VistA** button. To assign a staff member, click the **Select** icon. The **Staff Information** screen will display.
   - **Note:** If the Staff Role has been indicated for the team role, the staff member must match the person class in order for the assignment to occur. If the staff role has not been indicated for the team role, the staff member must match the person class for the Staff Role Provider Type(s) in order for the assignment to occur.
   - PCMM Web will validate the person class of the staff members assigned to the staff roles associated with the team roles of Primary Care Provider, Associate Provider, Care Manager, and Clinical Associate.
   - The PCMM Web VistA staff search will now display all staff members with the same last name in the search for staff results table even if the SSN field is blank in VistA.

4. Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member to narrow the search results. (E.g. Smith,J or Smith,Jo or Smith,Joness)

**Figure 30 - Search for Staff Role**
5. The **Assignment Date** field will default to the current date. To override, click the calendar icon and select a date and time. The date cannot be prior to the team role’s creation date. If needed, click the calendar icon next to the **Unassignment Date** field to add an unassignment date.

6. Enter a number in the **FTE** field. The FTE for the staff member assigned to this team role cannot be greater than 1.00 across all roles/teams to which he or she is assigned within a station or within station(s) with the same first three digits of the station number (i.e., the parent station).

   Expected, Actual and Vacant FTE:
   a. Expected FTE is the portion of a full time equivalent **required** to support the team and will default to 1.0 and may be edited to reflect a value of no less than 0.01.
   b. Actual FTE is the portion of the full time equivalent **available** to support the team.
   c. The Vacancy FTE is the difference between the expected and actual FTE and cannot be edited.
   d. If there is no staff available for this expected or required team role, the actual FTE value must reflect 0.00.

7. **Primary Care Provider Positions Only.** Select the **Temporary PCP** check box to identify staff temporary covering the Primary Care Provider (i.e., Locums, Gap providers).

8. When the PCP is providing TelePACT (virtual PCP), select the **Virtual PCP** check box.

   **Figure 31 - Staff Information Screen**

9. Click **Submit** to continue, **Cancel** to cancel. A success message and the staff member's name will display in the **Staff Name** column.

From the **Modify an Existing Position** screen:

1. From the **Modify an Existing Team** page, click **View Positions and Staff Assignments**. The **Position List** page displays. Click icon in the **Actions** column that corresponds to the team role.
2. The *Modify an Existing Position* screen will display. The *Current Staff Assignment* section will display *Staff Name, Role* and *Actual FTE*. Click the *Assign Staff* button to assign a staff member to the team role.

![Figure 32 - Position List Screen with the Action Icon Selected](image)

3. The *Staff Role* is displayed and can be edited.
   - **Note:** If the staff role has been indicated for the team role, the staff member must match the person class in order for the assignment to occur. If the staff role has not been indicated for the team role, the staff member must match the person class for the Staff Role Provider Type(s) in order for the assignment to occur.
   - PCMM Web will validate the person class of the staff members assigned to the staff roles associated with the team roles of Primary Care Provider, Associate Provider, Care Manager, and Clinical Associate.

![Figure 33 - Modify an Existing Position Screen with the Assign Staff Button Selected](image)

10. The *Search for Staff* dialog box displays. Enter the first two letters of a staff member's name, select a *Staff Role*, and click *Search*. If no staff member is found, click the *Search VistA* button. To assign a staff member, click the *Select* icon. The *Staff Information* screen will display.

![Figure 34 - Search for a Staff box with Staff Information Selected](image)
4. Follow the steps described above to assign the staff member to the team role.
5. When the assignment is created; the assignment date/status/reason will be captured in History.

**Mental Health Team Specifics:**

When assigning a staff member to a mental health team, each staff member is allowed to be assigned to more than one team role on the same team. This is needed since the staff member may serve as Mental Health Treatment Coordinator (MHTC) to some patents and not others.

**Preceptor/Preceptee Relationships**

<table>
<thead>
<tr>
<th>Preceptor</th>
<th>Preceptee</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>If the selected Role is Resident (Physician), Nurse Practitioner (NP), or Clinical Nurse Specialist</td>
<td><em>then</em> A user must indicate this team role needs to be associated with a staffed preceptor team role on the team in order to save the team.</td>
<td>&gt; A message to indicate that there is not a corresponding staffed preceptor team role currently available will be displayed if there is no current preceptor team role assigned.</td>
</tr>
<tr>
<td>If the Team PCP Role is <strong>Nurse Practitioner</strong> and is staffed</td>
<td><em>then</em> It may precept the Associate Provider <strong>Nurse Practitioner Student</strong>.</td>
<td></td>
</tr>
<tr>
<td>If the Team PCP Role is Physician Assistant and is staffed</td>
<td><em>then</em> It may precept the Associate Provider Team Role of <strong>Physicians Assistant Student</strong></td>
<td></td>
</tr>
</tbody>
</table>

June 2017 PCMM Web User Guide 24
If the Team Role is **Physician – <<Name>>** and is staffed then

- It may precept all Associate Provider staff roles.
- Physician Residents can be assigned to the Associate Provider Team Role only.

- Whenever a preceptor relationship is assigned or unassigned, history regarding the preceptor, the preceptee and their respective staff assignments and dates will be captured in the History.
- If the team role has an Active Preceptor or Preceptee assignment, the team role cannot be inactivated until all preceptor/preceptee assignments are removed.
- If the team role is a Preceptor, in order for the Status to be updated from Active to Inactive – all Active Preceptee Assignments for the team role must be unassigned.
- If the team role is a Preceptee, in order for the Status to be updated from Active to Inactive – all Active Preceptor Assignments for this team role must be unassigned.

**Assigning a Preceptor/Preceptee**

The user can setup and staff team roles that act as preceptors first and also to exist for the preceptees. The ability to establish a preceptor relationship cannot occur until both preceptee and preceptor roles are established and are staffed.

A user can assign a Preceptor to a team role:

1. From the *Modify an Existing Position* screen (locate the *Current Preceptor* section. Current Preceptor information is read-only on this screen. Click the **Manage Preceptor** button.
   - **Note:** Alternatively, if there is an existing Preceptor assignment, click the **Add Preceptor Assignment** button in the Preceptor Assignment Timeline section. Add a staff member only if more than one staff member is authorized to be a preceptor.
2. The *Create/Edit Preception Assignment* dialog box is displayed with the current information:
   - Click the calendar icon next to the **Relationship Start Date** field (required) to edit the start date. The current date/time is the default. A past date cannot be used.
   - Click the calendar icon next to the **Relationship End Date** field to enter an end date. This is not required, but a past date cannot be used.
   - Click the **Update** button to update the dates.
   - Preceptor information:
     - The current staff member is displayed in the **Staff Name** drop-down list. To change, select a new staff member from the drop-down list, if more than one staff member is authorized to be a preceptor.
     - **Staff Role**: Read-only
     - **Team Role**: Read-only
   - Preceptee information:
     - **Staff Name**: Read-only
     - **Staff Role**: Read-only
     - **Team Role**: Read-only

3. Click **Update** or click **Submit** to change the dates or Preceptor Staff Name. Click **Cancel** to cancel.

   **Figure 36 - Create/Edit Preception Assignment Screen**
4. A message will display to indicate the preceptor assignment was successful and the assignment/update data will be displayed in the Current Preceptor section. Click Close to close the dialog box.

**Preceptor Assignment Timeline:**

A user can edit an entry or add a new entry using this section.

To **Edit** an entry:
1. Click the **Edit** icon in the **Actions** column.
2. The **Create/Edit Preception Assignment** dialog box is displayed with the current information.
3. Modify the appropriate information.

To **Inactivate** an entry:
1. Click the **Inactivate** icon (red X) in the **Actions** column.
2. The **Are You Sure?** dialog box displays. Click **Confirm** to confirm, **Cancel** to cancel.
3. The Preceptor will be inactivated.
To **Delete** the entry:

1. Click the **Delete** icon in the **Actions** column.
2. Login to VistA if prompted (if already logged in, the prompted will not display).
   Confirm the deletion.
3. The record will be deleted.

*Figure 37 - Preceptor Assignment Timeline with Actions Icons Selected*

### Modify or View a Team Profile

PCMM Coordinators are able to modify and view teams.

1. Select **Teams** > **List All Teams** from the main menu to display the **Team List** page.

*Figure 38 - List All Teams Menu Option*

2. The following actions and information are available on the Team List page:
   - Team Name. Update a selected team by clicking the **Team Name**.
   - Station number
   - Primary Care Provider. Email a **Primary Care Provider** (if there is an email address available) by clicking the email envelope icon.
   - Access the **Position List** screen for the selected team by clicking the Positions icon.
   - Care Type
   - Focus (if there is a Focus 1 and a Focus 2 listed for the team, they will be listed in this column as Focus1 value/Focus2 value)
   - Station Number
   - Status
   - Admin POC and phone number. Contact an **Admin POC** by phone, or by email by clicking the email icon.
   - Assignment status
   - Assigned Active Total
   - Assigned Pending Total
- Available Capacity
- Generate a team by clicking the **Create A Team** button.

3. The team list will initially be displayed in order by Name and will include all teams. The list can be sorted by any column or narrowed by applying filter values for Care Type, Focus, Station, Status and Assignments.

4. To modify a team, click on a **team name** link. The **Modify an Existing Team** page will display and the user has the option to modify fields and options.

![Figure 39 - Create A Team Screen with a Name Selected](image)

5. Enter a new name for the team. If the new team name already exists for the site, an error message will appear.

6. Select a different **Focus 1** from the drop-down list.

7. Select a **Focus 2** from the drop-down list, or change the **Focus 2** selection.

8. Change the **Description**.

9. Click on the **Group Membership** name to view/change the group associated with the team.

**Point of Contact – Administrative section:**

Displays the administrator staff member, including a phone number and email address, assigned to the team. POC is assigned at the Team Role level.

**Point of Contact – Clinical section:**

Displays the point of contact staff member, including phone number and email address, assigned to the team. The POC is assigned at the Team Role level.

**Patient Capacity section:**

**Note:** Some fields may only display according to the Care Type.

10. Change the **Assignment Status** to allow or disallow future patient assignments to this team. *(Open is default).*

11. The maximum number of team members allowed for a team displays in the **Team Capacity** field.

12. View the **Station Modeled Capacity (Aggregated)** number for the team. Click the magnifying glass icon that corresponds to the **Modeled Team Capacity** to view a complete calculation.

13. Depending on Care Type and to override of the modeled capacity, select the **Allow Modeled Capacity Override** or **Allow Capacity Override** check box and enter a value in the **Modeled Capacity Override** or **Capacity Override** text box. Enter a reason for the override (mandatory) in the **Justification** text box.

14. Click the magnifying glass icon that corresponds to the **Available Capacity** to view the available assignments. The system will identify the number of available
assignments by calculating the difference between the sum of the pending and active assignments from the team capacity.

15. The **Assigned PENDING Total** field displays the number of assignments with a pending status.

16. The **Assigned ACTIVE Total** field displays the number of assignments with an active status.

17. The **Assigned ALL Totals** field displays the number of assignments available.

Figure 40 - Modify an Existing Team Screen

18. A confirmation message will display if any changes occur.

19. The **Reconcile the team against applicable models** option will display on the Modify an Existing Team screen. The option **No** is automatically selected. Select **Yes** to view the reconciliation results and the model linked to the team.

**Non-Primary Care or Non-VA Teams:**

- The Aggregated Modeled Team Capacity calculations will not be applied to Non-Primary Care or Non-VA teams and therefore, will not be displayed in the Patient Capacity section.
- If the team created is NOT a Primary Care Team, a user can manually enter a panel size on the View/Adjusted Modeled Capacity screen. This number will display in the Patient Capacity section as the Team Capacity.

**Status Change section:**

Users can change the team's status by clicking the **View/Edit Complete Timeline** link in the **Status Change Timeline** box near the bottom of the screen.

To edit an entry:
1. Select the **Actions** (pencil) icon that corresponds with the entry to edit.  
   ![Figure 41 - Status Change Timeline Screen]

2. Select the status of entry from the **Status** drop-down menu.  
3. Click the calendar icon next to the **Effective Date** field to select the date and time the status will be effective.  
4. Select a reason for the team entry from the **Status Reason** drop-down list.  
5. Click **Submit**, or **Cancel** to cancel the changes.  
   ![Figure 42 - Update Entry Box]

6. A confirmation message will display. Click **Close**.

To add a new entry:

1. Click the **Add Entry** button.  
   ![Figure 43 - Status Change Timeline Screen with the Add Entry Button Selected]

2. Select the status of entry from the **Status** drop-down menu.  
3. Click the calendar icon next to the **Effective Date** field to select the date and time the status will be effective.  
4. Select a reason for the team entry from the **Status Reason** drop-down list.  
5. Click **Submit**, or **Cancel** to cancel the changes.
6. A confirmation message will display.
   - All Active staff assignments and all Active positions on the team will be automatically unassigned and Inactivated when the Team is inactivated.
   - In order for the Status to be updated from Active to Inactive, all Active team roles for the team must be unassigned.
   - If the Status is updated from Active to Inactive; the Inactive Date must be greater or equal to the Active Date.
   - The Status Date and Status Reason are required and must be entered anytime the Status is changed.
   - The status history will also be shown in this list.

Modify or View a Team Role (Position)

A user can modify or view team role attributes through the Modify an Existing Position screen.

1. Locate the team to view.
2. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.

3. The following actions and information are available on the Position List screen:
   - Click the Create a Position button to create a new team role.
   - Click the Reconcile with Models button to reconcile the team roles with the available team models.
   - Team Role
   - Staff Role
- Staff Name. Click the Staff Name link to view details about the staff member. For an unassigned team role, click the Not Assigned link to assign a staff member to a team role.
- Preceptor
- Preceptee(s)
- Status
- Expected FTE*
- Actual FTE*
- Vacant FTE*
- Assigned Active
- Actions
- View the team model by clicking the View the Model linked to the Team link. The team care type, focus, station, all model team roles and if the roles are required are displayed. Click Close the Model to hide this information.

*FTE: Full Time Equivalent. A FTE of 1.0 and indicates that the team role is a full-time. A FTE of 0.5 indicates the team role will be available half-time.

4. Click the icon in the Action column that corresponds to the desired team role to update. The Modify an Existing Position screen will display.

Figure 46 - Position List with the Actions Icon Selected

General Section

5. The role in the Team Role drop-down list cannot be updated. A Team Role other than the required Teamlet Roles, may be established more than once within the team. The Description may be used to differentiate between two identical roles. However, if there are two staff roles on the team with the same role at the same time (active at a certain date), a message indicates the team is inconsistent.
- Note: Primary Care Provider (PCP), RN Care Manager, Clinical Associate, and Administrative Associate Primary Care teamlet roles are restricted to one per PACT.

6. Enter a description of the team role in Description text box. The maximum length is 250 characters.

7. Enter the FTE number the team role would be expect to provide for in the Expected FTE field. It must be greater than 0.00 and it cannot be greater than 1.00.
Current Staff Assignment

If there is staff members assigned to the team, the following information is displayed:
- Staff Name
- Staff Role
- Actual FTE
- Temporary PCP

8. Click the **Manage Staff** button to view the *Staff Information* screen. A user can reassign or unassign a staff member to a team role and update the FTE number.

Current Preceptor

If there is preceptor assigned to the team, the following information is displayed:
- Staff Name
- Staff Role
- Team Role

9. If a Preceptor is not assigned, click the **Manage Preceptor** button to display the check box to make the team role the team lead. There may only be one Active *Primary Care* role per team.

Team Placement Section

10. Select the **Team Lead** check box to make the team role the team lead. There may only be one Active *Primary Care* role per team.
11. Select the **Point of Contact – Administrative** check box to make the team role the primary point of contact for the team. There may only be one active primary point of contact per team.
12. Select the **Point of Contact – Clinical** check box to make the team role the secondary point of contact for the team. There may be multiple secondary points of contacts.
13. Establish team roles that can act as preceptors in order to exist for the preceptees.

Patient Capacity Section

The system will automatically display the allowed patient capacity for the calculated team model.

14. To override this number, select the **Allow Position Capacity Override** check box.
15. Enter the number of Patients that will be allowed to be assigned to the team in the **Position Capacity Override** text box.
16. If desired, enter a justification for the override in the **Justification** text box.
17. Click the magnifying glass icon that corresponds to the **Available Capacity** to view the available assignments. The system will identify the number of available assignments by calculating the difference between the sum of the pending and active assignments from the team capacity.
18. The **Assigned PENDING Total** field displays the number of assignments with a pending status.
19. The **Assigned ACTIVE Total** field displays the number of assignments with an active status.
20. The **Assigned ALL Totals** field displays the number of assignments available.
21. Click the **View/Edit the Notification Distribution Rules** link to view a list of notification types and settings for the team.
22. Click the Submit button to save the information to the database.

- In order for the Status to be updated from Active to Inactive, all Active Patient Assignments for the team role must be unassigned.
- If the team role is a Preceptor, in order for the Status to be updated from Active to Inactive, all Active Preceptee Assignments for the team role must be unassigned.
- If the Status is updated from Active to Inactive; the Inactive Date must be greater or equal to the Active Date.
- The Status Date and Status Reason are required and must be entered anytime the Status is changed.

Open the View Patient Assignments section to view a list of patients assigned to the team. When selected, the Historical Assignments option displays patients previously assigned to team. To revert to the current list, select the Current Assignments option. To filter through the patient list, use the text box provided. Quickly assign or reassign one or more patient to and from a team or a team role using the Perform Batch Operations button. Click a patient name to view the Patient Profile screen. Note: Since the patients are assigned to the entire team UNLESS the team has Associate Provider roles(s) established (the user can choose whether they want to assign the PCP or AP to the patient), the patient assignments will vary depending on how the team is set up and staffed.

- A user can delete a team role that is not a part of the basic team model configuration, if no patients have been assigned to the team. From the Position List screen, click the delete icon in the Actions column that corresponds to the team role. If the delete icon is not present, either the team role is a required for the team model, and the team has been reconciled against that model, or there have been patients assigned to the team. The team role can be inactivated.

Open the Staff Assignment Timeline section to view a list of staff records moved from the Current Assignment. The Staff Assignment Timeline includes the Staff Name, Staff Role, Actual FTE, End Date, Reason, Unassignment Reason (if applicable) of all staff members assigned to/unassigned from the team role. A user can add, update and delete an entry in the Staff Assignment Timeline by clicking the icons or update an assignment by clicking the New Assignment button. The New FTE Entry button enables a user to update the FTE and Effective Date.

Open the Preceptor Assignment Timeline section to view a list of preceptor assignments. The Preceptor Assignment Timeline includes the Start Date, End Date, Preceptor and Preceptee information. A user can edit or add a new preceptor from this list by clicking the Add Preceptor Assignment button.
**View or Modify Team Role (Position) History**

A user can view a history of assignments and unassignments for a team role.

**From the Team List screen:**
1. From the main menu, click **Teams > List All Teams** to display the *Team List* page.

   **Figure 48 - List All Teams Menu Option**

2. Click an item in the **Position** column for the desired team to display the *Positions List* page. The team must be active.

   **Figure 49 - Create a Team Screen with the Positions Icon Selected**
From the Modify an Existing Team screen:

3. From the main menu, click Teams > Search for a Team to display the Search for Team box. Enter the search criteria and click on the team name link.

Figure 50 - Search for Team Menu Option

4. From the Modify an Existing Team screen, click the View Positions and Staff Assignments link. The Position List page will display.

Figure 51 - View Positions & Staff Assignments Link Selected to Modify a Team Role

5. From the Position List page, click the corresponding icon in the Actions column. The Modify an Existing Team Position screen will display.

Figure 52 - Position List Screen with Actions Icon Selected to Modify the Team Role
6. In the *Status Change Timeline* section at the bottom of the screen, click the **View/Edit Complete Timeline** link to display the history information.

**Figure 53 - View/Edit Complete Timeline Link Selected**

To Update an Existing Entry:
1. A user can change the team role status to **Inactive** by clicking the (pencil) icon in the Actions column. The Update Entry dialog box will display.

**Figure 54 - Updating an Existing Entry**

2. Select a **Status**, **Effective Date** (current date/time is selected by default, and a user cannot choose a past date), and **Status Reason**.
3. Click **Submit** to continue, **Cancel** to cancel. A confirmation message will display in the dialog box and click **Close** to continue. The updated entry will display.

**Figure 55 - Update Entry Box When Modifying a Team Role**
4. Click the Close Timeline link to close this section.

To Add an Entry:

1. A user can add an entry to the timeline by clicking the Add Entry button. The Add Entry dialog box will display.

   **Figure 56 - Add An Entry Button Selected**

2. Select a Status, Effective Date (current date/time is selected by default, and a user cannot choose a past date), and Status Reason.
3. Click Submit to continue, Cancel to cancel. A confirmation message will display in the dialog box and click Close to continue. The new entry will display in the list.

   **Figure 57 - Add Entry Box**
View Team Role (Position) Attribute Change History

A user can view the adjusted capacity change history and the justification for capacity adjustment change history from the History of Position Attribute Changes screen.

1. From the Modify an Existing Position screen, click the View Position Attribute Change History link below the Submit button. The History of Position Attribute Changes screen will display.

   Figure 58 – View Position Attribute Change History Link Selected

2. Open the Adjusted Capacity Change History section to view the adjusted capacity change history of the team. This is displayed in a table format with the following columns: Changed From, Changed To, Changed By, and Changed On date columns. A user can click the email icon (envelope) in the Changed By column to email the staff member.

   Figure 59 – Adjusted Capacity Change History Section Expanded
3. Open the **Justification for Capacity Adjustment Change History** section to view the justification for the capacity adjustment change history. This is displayed in a table format with the following columns: *Changed From*, *Changed To*, *Changed By*, and *Changed On* date columns. A user can click the email icon (envelope) in the *Changed By* column to email the staff member.

**Figure 60 - View Justification for Capacity Adjustment Change History Section Expanded**

**View Team Attributes Change History**

A user can view several team change history statistics using the View Team Attributes Change History link.

1. From the *Modify an Existing Team* screen, click the **View Team Attribute Change History** link near the bottom of the screen.

**Figure 61 - View Team Attribute Change History Link Selected**
2. The **History of Team Attribute Changes** screen displays with the following sections:
   - View Team Name Change History
   - View Care Type Change History
   - View Focus Change History
   - View Assignment Status Change History
   - View Adjusted Capacity Change History
   - View Calculated Model Capacity -- based on the Team Change History’

   ![Figure 62 - History of Team Attribute Change Full Screen](image)
3. Each of these sections contains the associated data for that section in a standard table format with the following columns: Changed From, Changed To, Changed By, and Changed On date columns. A user can click the e-mail icon (envelope) to e-mail the Changed By staff member if they have an e-mail address associated with their record.

4. Open each section to view the data associated with that section.

Figure 63 - View Team Name Change & View Care Type History Sections Expanded

---

**Validate Team Data Consistency**

A user can check for data consistency errors using the Validate Team Data Consistency functionality.

1. From the Modify an Existing Team screen, click the Validate Team Data Consistency link located at the bottom of the page.

Figure 64 - Validate Team Data Consistency Link Selected
2. A message box will display, indicating if there are any data consistency errors or if none are found. Correct any data consistency error. Click **Close**.

**Figure 65 - No Data Consistency Errors Were Found Message**

---

**Search for a Team by Name**

A user can search for a team using the following options:
- the **Search for Team** screen.
- the **Patient Assignments** section of the **Patient Profile** screen.
- the **Team List** screen.

Any of these search methods enable a user to modify or view a team’s profile. **Using the Search for Team screen:**

1. From the main menu, select **Teams > Search for Team** to display the **Search for Team** screen.

**Figure 66 - Search for Team Menu Option**
2. Enter part or all of a team’s name in the **Name** field and click **Search** to display the teams that match the search criteria. Alternatively, click the **Search** button to view a list of all teams.

3. Click the **team name** link in the **Name** column to display the *Modify an Existing Team* page.

**Figure 67 - Search for A Team Box with a Team Selected**

Using the Team List screen:

1. From the main menu, select **Teams > List All Teams** to display the *Team List* screen.

**Figure 68 - List All Teams Menu Option**

2. Scroll down, or use the navigation buttons at the bottom of the page to locate the team's name in the list.
3. Click on the **team name** link in the **Name** column to display the **Modify an Existing Team** page.

**Figure 69 - Team List with Team Name Selected**

**Using the Patient Profile screen:**

1. From the **Patient Profile** page, click the **View Team Assignments** toggle link to display a section that indicates what team(s) the patient is (has been) assigned to.
2. Click on the **team name** link in the **Team** column to display the **Modify an Existing Team** page.

**Figure 70 - Patient Profile with Team Name Selected**

**Assign a Surrogate**

A PCMM teamlet surrogate is a specific individual in a similar role that is assigned to cover for the corresponding PACT staff-member during short-term or unplanned absences. When a new team is created using the team type of Primary Care, the surrogate team roles of Surrogate Primary Care Provider, Surrogate Care Manager, Surrogate Clinical Associate, and Surrogate Administrative Associate will auto-populate.

A user can assign someone to receive their PCMM Web notifications from the notification distribution list while they are away during a specific time frame. A surrogate receives notifications for a specified team role during a specified date range and can act upon the notifications.

**From the Position List screen:**
1. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.

**Figure 71 - View Positions & Staff Link Selected to Assign a Surrogate**

2. Locate the Surrogate Team Role type to assign a staff member to and click the Not Assigned link to display the Search for Staff screen.

   **Note:** For Primary Care Type teams, a user can assign a Surrogate Administrative Associate, Associate Provider, Care Manager, Clinical Associate, or Primary Care Provider.

**Figure 72 - Assign a Surrogate on the Position List Screen**

3. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Select a Staff Role from the drop-down list.
   a. A terminated staff member is shown as “Separated” in the search results.
   b. Total FTE column includes the sum of team assignments associated with the staff member.

4. Click Search to display a list of staff names results. Click Cancel to cancel the search.

5. Click the icon in the Select column to view the staff member’s profile. The Staff Profile screen will display.

**Figure 73 - Search for Staff to Assign a Surrogate**
6. Click the calendar icon next to **Unassignment Date** field to change the unassignment date (current date and time is displayed by default).
7. Choose an **Unassignment Reason** from the drop-down list.
8. Enter a number in the **FTE** field.
9. Click the **Submit** to assign the staff member as a Surrogate.

**Figure 74 - Assigning a Surrogate on the Staff Information Screen**

From the **Modify an Existing Position** screen:

10. From the **Modify an Existing Team** page, click **View Positions and Staff Assignments**. The **Position List** page displays. Click icon in the **Actions** column that corresponds to the surrogate team role to staff.

**Figure 75 – Position List Screen with the Actions Icon Selected to Assign a Surrogate**
11. The Modify an Existing Position screen will display. The Current Staff Assignment section will display Staff Name, Role, and Actual FTE. Click the Assign Staff button to assign a staff member to the team role. The Search for Staff box displays.

Figure 76 - Modify an Existing Position with the Assign Staff Button Selected

12. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Select a Staff Role from the drop-down list.
   a. A terminated staff member is shown as “Separated” in the search results.
   b. Total FTE column includes the sum of team assignments associated with the staff member.

11. Click Search to display a list of staff names results. Click Cancel to cancel the search.
13. Click the icon in the Select column to view the staff member’s profile. The Staff Profile screen will display.
14. Click the calendar icon next to **Unassignment Date** field to change the unassignment date (current date and time is displayed by default).
15. Choose an **Unassignment Reason** from the drop-down list.
16. Enter a number in the **FTE** field.
17. Click the **Submit** to assign the staff member as a Surrogate.

**Modify or View Surrogate Staff Assignments**

A surrogate receives notifications for a specified team role during a specified date range and can act upon the notifications.

1. From the Position List, select the icon in the **Actions** column in the same row of the Surrogate assignment to display the **Modify an Existing Position** screen.
2. In the Staff Assignments Timeline section, choose a staff member and click the edit (pencil) icon to view the Modify an Existing Position page.

Figure 80 - Modify Surrogate from the Staff Assignment Timeline Section

3. A message will display, indicating modifications may affect the preceptor assignments. Click Confirm or Cancel.

Figure 81 - Edit Entry Message

4. Click the Search Staff button to assign a new Surrogate to the position.
5. Enter a different Assignment Date and/or a different Unassignment Date using the calendar icons.

Figure 82 - Updating Assignment Date for a Surrogate
6. Click **Submit**, or **Cancel** to cancel any changes.
   - A success message will display, and a user can view the new changes in the *View Surrogate Staff Assignments* table.
   - A user can also choose to delete the staff member from the list. Click the **Delete** icon. A success message will display, and a user can view the new changes in the *View Surrogate Staff Assignments* table.

### Reconcile Team with Models

After creating a team or a team role on a team, a user can update the team profile with other available models.

**Note:** The team must be active for the system to perform this action.

1. Locate the desired team to reconcile. From the *Modify an Existing Team* screen, click the **View Positions & Staff Assignments** link. The Position List screen will display.

   **Figure 83 - View Positions & Staff Assignment Link Selected to Reconcile Team with Models**

   ![Screen shot of Modify an Existing Team with View Positions & Staff Assignments link highlighted](image)

2. Click the **Reconcile with Models** button to refresh the screen. If reconciliation took place, a confirmation message will appear at the top of the screen. A delete icon will appear in the **Actions** column for any team role that does not match the model. A user can view the reconciliation results and the model linked to the team by clicking the links at the bottom of the page.

   **Figure 84 - Position List Screen with Message Displaying Team was Reconciled Against Models**

   ![Screen shot of Position List with message displayed](image)
Maintain a Team Model Configuration

This task is limited to users with specific permissions and allows a user to search for or create a configuration a team model.

1. Select **Teams > Search Model Configuration** from the main menu to display the **Search for/Create Model Configuration** screen.

   ![Figure 85 - Search Model Configuration Menu Option](image)

2. Select the care type from the **Care Type** drop-down list.
3. If needed, select a focus from the **Focus** drop-down list.
4. Enter the name of a station in the **Station** text box or select a station name from the list.
5. Click **Find** to display a list of model configurations at the bottom of the screen. If no configurations are found, a message will display.

   ![Figure 86 - Search for Create Model Configuration Screen](image)

6. When a team profile is submitted and saved for the first time, the system will automatically create the team roles defined in the Model Team Configuration. The Model Team Configuration is established at the National level and can be overridden if needed at the station level. It represents the required team roles as well as any
optional roles that normally exist for the team based on Care Type and Focus (optionally).

- The system first will check for the existence of a Model Team Configuration for the Team Care Type and the Team Focus for the station number a user is logged into. If a Model Team Configuration does not exist for the Team Care Type and the Team Focus for a station, the National Model Team Configuration will be used.
- If there is a Model Team Configuration for Team Care Type and not the Team Focus, the Model Team Configuration for the Team Care Type for the station will be used. If there is not a Model Team Configuration for the Team Care Type, the National Team Configuration Model will be used.
- If there is not a Model Team Configuration in existence at the National level for a Team Care Type, there will not be any team roles automatically created.
- If a Model Team Configuration has been applied to the team, the results of the Team Position creation will be displayed.

7. An alert will be generated and sent to each recipient when a Team is created notifying the user that the Model Team Configuration for a team was created/updated in the Alert Rules for additional information on alert types and who they are sent to.

8. A user will have the ability to navigate to the current Model Team Configuration applicable to the team.

**Note:** Any team roles created by the System will appear in the Team Configuration List along with any team roles created by a PCMM Web user.

### Create a Role for a Team Model Configuration

A user can create a new model role for a model team:

1. Select **Teams > Search Model Configuration** from the main menu to display the *Search for/Create Model Configuration* screen.

   **Figure 87 - Search Model Configuration Menu Option**

2. Select the **Care Type**, **Focus**, and **Station**. Select a Role from the **Role** drop-down list.
3. Check the **Required** check box if the role is to be required for the team.
4. Click the **Yes** button to notify the PCMM Coordinators of the change. **No** is selected by default.
5. Click **Submit** to continue, **Cancel** to cancel. A confirmation message will display.
Calculate Model Panel Size – Selection of Care Type

1. Select **Teams > View/Adjust Station Modeled Capacity Calculation** from the main menu to display the **Model Panel Size Calculator – Selection of Care Type** screen.
   - **Note:** This action and menu option is limited to specific users.

   **Figure 88 - View/Adjust Station Modeled Capacity Calculation Menu Option**

1. Select a care type from the **Care Type** drop-down menu.
   - Select the **Primary Care** type to display the **Calculate Model Panel Size – Primary Care Worksheet** screen.
   - Select any other care type to display the **Model Panel Size Calculation – Adjustment of Model Capacity** screen.
2. Click **Submit** to continue, **Cancel** to cancel.

   **Figure 89 - Model Panel Size Calculation - Selection of Care Type Screen**

**Calculate Model Panel Size - Primary Care Worksheet**

A user can calculate the model panel size for a Primary Care team through the **Primary Care Worksheet** screen.

If a user has selected the **Primary Care** type from the **View/Adjust Modeled Panel Size Calculator** screen, the **Calculate Model Panel Size – Primary Care Worksheet** screen will display.

The data is displayed in a table with two columns: **Measure** and **Value**. The last column lists the final **Adjusted Model Panel Size**.

**Note:** This action and menu option is limited to specific users.
In addition, a user can view information by clicking the toggle control for the tables below:

- View Primary Care Intensity Based Adjustment
- View Support Staff per PC FTE Based Adjustment
- View Rooms per PC FTE Based Adjustment
- View Modeled Panel Size Change History

**Figure 90 - Model Panel Size Calculation - Worksheet for Primary Care Team Screen**

View Primary Care Intensity Based Adjustment

The table in this section displays a summary of calculation results, including measure, value, intensity ranges and their effect on Model Panel Size, and the Adjustment of Modeled Panel size in percent. An icon (green check) displays at the end if the percentage is within range.

**Figure 91 - Summary of Calculation Results Screen**

View Support Staff per PC FTE Based Adjustment

The table in this section lists the Active Primary Care teams for the station with their PC and Support Staff Team Positions. Table data includes Team name, Support Staff Team Positions, Total Team Support Staff FTE, Primary Care Provider Team Positions, and Total Team Primary Care Provider FTE.
• Click a **team name** link in the **Team Name** column to open the **Modify an Existing Team** screen for that team.

• Click a team role link in the **Support Staff Team Positions** column to open the **Modify an Existing Position** screen for that team role associated with the team.

• Click a Primary Care team role link in the **Primary Care Provider Team Positions** column to open the **Modify an Existing Position** screen for that Primary Care team role associated with the team.

**Figure 92 - Action Primary Care Teams Screen**

<table>
<thead>
<tr>
<th>Measure</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Support Staff FTE</td>
<td>17.44</td>
</tr>
<tr>
<td>Total Primary Care Provider FTE</td>
<td>27.44</td>
</tr>
<tr>
<td>Total Support Staff Per PCP FTE</td>
<td>0.65</td>
</tr>
<tr>
<td>Adjustment for Support Staff Per PCP FTE</td>
<td>-1.58</td>
</tr>
</tbody>
</table>

**Support Staff per PCP FTE Ranges and their effect on Station Modeled Capacity (Aggregate)**

<table>
<thead>
<tr>
<th>Support Staff per PCP FTE Range Between...</th>
<th>Adjustment to Station Modeled Capacity (Aggregate) (Percent)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00 and less than 2.00</td>
<td>15.00</td>
</tr>
<tr>
<td>2.00 and less than 2.35</td>
<td>-3.60</td>
</tr>
<tr>
<td>2.00 and less than 3.45</td>
<td>0.00</td>
</tr>
<tr>
<td>3.45 and less than 3.75</td>
<td>5.00</td>
</tr>
<tr>
<td>3.75 and above</td>
<td>10.00</td>
</tr>
</tbody>
</table>

At the bottom of the table are displayed the **Summary of Calculation Results**, the associated table with **measure and value** columns, and the **Support Staff per PC FTE Ranges and their effect on Model Panel Size**.

**View Rooms per PC FTE Based Adjustment**

The table in this section displays the Active Primary Care Teams with Room Assignments data with the following columns: Team Name, Examination Room Assignments, Interview Room Assignments, and Total Room Assignments for the team.

• Click a **team name** link in the **Team Name** column to open the **Modify an Existing Team** screen for that team.

• Click on an **Examination Room Assignments** link, if available, to go to the **Modify an Existing Room** screen.

• At the bottom of the list is displayed the Institution Totals (FTE)

At the bottom of the table are displayed the **Summary of Calculation Results**, the associated table with **measure and value** columns, the **Total Rooms per PC Provider FTE**, and the **Adjustment**. The last table displays the **Rooms per PC FTE Ranges and their effect on Model Panel Size**: the columns displayed are **Rooms per PC FTE Range Between...** and **Adjustment to Modeled Panel Size in Percent**.

**Figure 93 - Action Primary Care Teams with Room Assignments**
View Modeled Panel Size Change History

The compilation table in this section displays the following columns: Model Size, Start Date, End Date, Primary Care Intensity, Intensity Based Adjustment, Total Support Staff FTE, Total PC FTE, Support Staff per PC FTE, Support Staff Based Adjustment, Total Rooms FTE, Rooms per PC FTE, and the Rooms Based Adjustment.

**Figure 94 - View Modeled Panel Size Change History Section**

Calculate Model Panel Size - Adjust Capacity

A user can calculate the model panel size for a team other than a Primary Care team through the Model Panel Size Calculation - Adjustment of Modeled Capacity screen.

If another care type other than the Primary Care is selected from the View/Adjust Modeled Panel Size Calculator screen, the Model Panel Size Calculation - Adjustment of Modeled Capacity screen will display.

1. The Station and Care Type is read-only.
2. Enter a number for the Specify Modeled Capacity field (the most current number is the default).
3. Click Submit to continue, Cancel to cancel. A success message will display.

**Figure 95 - Model Panel Size Calculation - Adjustment of Modeled Capacity Screen**
4. A user can view the **Modeled Size Change History** by clicking the toggle control to display the table data. The table contains three columns: Model Size, Start Date and End Date, if available. This is a read-only table.

**Figure 96 - View Modeled Size Change History Section**

**Update Primary Care Intensity**

A user with the role of National Coordinator can update the primary care intensity score for a station. This enables the modeled team capacity calculations at a station and team level to be adjusted as needed.

1. From the main menu, select **Teams > Update Primary Care Intensity** from the main menu to display the **Update Primary Care Intensity** screen. The station a user is currently signed into appears in the Station field and is read-only.
2. Update the value in the **Primary Care Intensity** field (X.XX format).
3. Click **Submit** to save the change or **Cancel** to return to the PCMM Web home page without saving the change. A confirmation message will display.

**Note:** If the Primary Care Intensity is changed, individual team modeled capacities may be automatically changed by the system.
PATIENT MANAGEMENT

Assign a Patient to a Team

A patient can be assigned to a team from the Patient Profile screen.

1. From the Patient drop-down menu, select Search for Patient to display the Search for Patient screen.

   Figure 97 - Search for Patient Menu Option

2. Enter the following search criteria:

   - Enter the first initial of the last name, plus the last 4 digits of a social security number.
   - Enter the Social Security number (complete in xxx-xx-xxxx format) in the SSN text box.
   - Enter the patient’s last name in the Last Name text box.
   - Enter the patient’s first name in the First Name text box.
   - Click Find to display the patient information or a list of patients in the lower part of the screen that match the search criteria.

Note: A user must enter at least the first initial or last 4 digits of SSN, last name, first name OR full SSN to execute a Patient Search.

   Figure 98 - Assigning a Patient to a Team

   - If patient record is labeled as Sensitive Patient, the SSN and DOB are masked.
   - If the system returns more than the maximum number of records allowed, the complete list of records will not display. A user can filter the search criteria further (described below), or search for the patient in VistA.
   - The system will display the Perform Batch Actions button at the bottom of the search results list.
Note: View the Search for a Patient section for a further details on how to search for a patient.

3. Select the patient name link to display the Patient Profile screen.
4. In the View Team Assignments section on the Patient Profile, click the Assign button to display the Search for Team box.

![Figure 99 - View Team Assignments Section](image)

5. Enter a team name in the Name field or click the Search button, to search for a team. Select the Entire Team link to assign the patient to the team or select the available position link (e.g., Associate Provider).

![Figure 100 - Assigning a Patient to a Team From the Search for Team Box](image)

6. If assigning to a Primary Care Team Care Type, a confirmation message displays to indicate the patient is successfully assigned to a team. For other Primary Care types (e.g., Mental Health, Community Care), the Team Assignment displays with additional steps.
7. Accept the default current date or enter a date for the Effective Date field. The effective date must be greater than the team’s Active Date and cannot be a future date.
8. In the Assign to section, select the check box beside the appropriate staff member to assign the staff member to the patient. The Mental Health Care Type is used as an example.
9. Click **Submit** to assign the patient to the team. A confirmation message will appear if the assignment was successful. Click **OK** to continue.

**Figure 102 - Attention Message After a Patient is Assigned to a Team**

10. Patient assignments to Primary Care teams will have an initial status of pending until a qualifying encounter is found (within last 60 days). The effective date of the Pending assignment will default to the current date and time the assignment is entered. When the system identifies a qualifying encounter, the status will update from Pending to Active with an effective date equal to the qualifying encounter date (at midnight for those assignments entered before the appointment and real-time for those entered after the completed encounter if within the last 60 days). For all other care types, the initial status will be Active and the Effective Date will be the date entered during the assignment.

- A patient with a Date of Death (DOD) is not allowed to be assigned to a team.
- An assignment status will be **Pending** when initially assigned to a PACT, and will remain pending until a completed qualifying teamlet encounter is found. Then, the assignment status converts to **Active**. If the patient is assigned to a non-PC team, the entered assignment will be active.
- The patient’s PACT assignments will be evaluated enterprise wide to determine if an active PACT assignment exists in another 3-digit code station.
- A patient can be assigned to more than one non-primary care team.
- The assignment will occur at the **Team** level, except in the case of a team with a Purpose of Primary Care. All active roles on the team will inherit the team assignment regardless of whether it is staffed or not. PCPs and/or Associate Providers on the team will be shown and a user will be able to select current and active PCP or Associate Provider for patient assignment.
• All active roles on the PACT team will inherit the team assignment regardless of whether it is staffed or not.
  o Associate Providers may be added to the PACT and a user will be able to assign specific patients to each AP role.
• The Assignment Effective Date is defaulted to the current date and will allow a user to override it, but not prior to the team’s creation date or last team discharge date, whichever is latest.
• If the team is closed, assignment is not allowed. Teams Closed for Assignment will not appear in the Team Search results list.
• If the team has reached its allowed patient capacity, a warning message states that the allowed patient capacity has been reached; however, and the assignment can continue.
• If the team has reached its overridden maximum patient capacity, a warning message will be displayed to indicate the maximum allowed patient capacity has been reached and the assignment can continue.

Assigning Patients to a Primary HBPC Team:

• HBPC does not have pending status. HBPC assignments immediately change to a ACTIVE status when assigned to a patient.
• If the patient has a HBPC team assignment and the user tries to assign a PACT team, the HBPC assignment is inactivated and the PACT assignment goes to PENDING unless a valid teamlet encounter is found which will disposition the PACT assignment to ACTIVE.
• If the patient has a PENDING or ACTIVE PACT assignment and the user tries to assign a HBPC team, the PACT assignment will be dispositioned to either INACTIVE or CANCELED and the HBPC assignment goes to ACTIVE.
• The user must use the “mass reassignment” function to transfer multiple patients from one HBPC team to another HBPC team.
• HBPC team assignment for a single patient from one HBPC team to another HBPC team, the user must unassign the patient from one HBPC team and then assign the patient to the other HBPC team. The “Assign” button process will not work for HBPC teams if the user is trying to reassign the patient to another HBPC team since PC - HBPC care type does not allow a patient to have more than 1 HBPC team assignment within the same 3-digit station code. Therefore using the Assign function will not work and will continually give the user an error.

Search for a Patient

When searching for a patient, a user can only view patient information on a need-to-know basis. The role assigned to the user dictates the patient information they are allowed to view. Typically, a user is restricted to viewing patient information only for those patients assigned to the station or stations that has/have been assigned to their User ID.

Note: An employee cannot view their own data.

1. From the Patient drop-down menu, select Search for Patient to display the Search for Patient screen.
2. Enter the following search criteria:

- Enter the first initial of the last name, plus the last 4 digits of a social security number.
- Enter the Social Security number (complete in xxx-xx-xxxx format) in the **SSN** text box.
- Enter the patient's last name in the **Last Name** text box.
- Enter the patient's first name in the **First Name** text box.
- Click **Find** to display the patient information or a list of patients in the lower part of the screen that match the search criteria.

**Note:** A user must enter at least the first initial or last 4 digits of SSN, last name, first name OR full SSN to execute a Patient Search.

3. If the system cannot find a patient that matches the criteria entered, the following message will display: “No matches found for the criteria entered. Validate or expand your search criteria.” Click **Close** to exit out the message box. The system will display an additional **Find in VistA** button. VistA requires at least three letters of the last name, OR the full SSN, first name, and Date of Birth to perform a search. Enter the search criteria and select the **Find in VistA** button.

**Note:** Ensure each PCMM Web user has VistA privileges for the station(s) they have access to in PCMM Web. If not, an error may display.

4. The screen will refresh with the VistA results displayed. If no records match criteria, a message will display. Validate or try the search criteria again.
5. To add the VistA patient, select the **Name** link which navigates to the Patients Profile screen.

6. Once a patient is selected, the system will check to see if the patient is:
   - A known patient to PCMM Web for the local station (no further action is required)
   - A new patient to PCMM Web.
   - If the patient record cannot be imported into PCMM Web, a message will display.

7. Choose **Select** to validate the patient record; the *Patient Profile* is displayed.

**Note:** Once a patient is pulled into PCMM Web from VistA, the patient will no longer appear in the VistA search results, only in the PCMM Web search results.

## View or Modify a Patient Profile

A user can view or modify a patient’s profile on the *Patient Profile* screen.

1. From the **Patient** drop-down menu, select **Search for Patient** to display the *Search for Patient* screen.

   **Figure 105 - Search for Patient Menu Option to View or Modify a Patient Profile**

2. Enter the necessary data to narrow the search and click **Find** to display the patient information or a list of patient names.

   **Figure 106 - Search for Patient Screen to View or Modify a Patient Profile**

3. Click on a **patient name link** in the PCMM Search Results to display the *Patient Profile* screen.
The Patient Profile screen displays:

- Patient Demographics
- Team Assignments for the Patient
- Multiple Primary Care Provider Requests
- Active Non-VA Providers
- Inactive Non-VA Providers History
- Panel Placement Requests

From this screen, a user can:

- Assign, and unassign a Patient to or from a team (if a user has permission)
- Reassign the direct care provider
- Update/Review a Patient's Multiple PCP Requests
- View/Search/Assign for an active Non-VA providers
- View/Create PACT Panel Requests
Assign Patient to a PACT Team

The following steps explain how to assign a patient to a PACT Team.

1. To assign the patient to a team, navigate to the Patient Profile screen. In the View Team Assignments section, click the Assign button to display the Search for Team box.

2. Enter a team name in the Name field or click the Search button, to search for a team. Select the Entire Team link to assign the patient to the team.
   - **Note:** If Entire Team is selected, this assignment will be inherited by all Teamlet team roles, with an explicit assignment to the PCP.

3. Click Submit to assign the patient to the team. A confirmation message will appear if the assignment was successful. Click OK to continue.
   - **Note:** Depending on the Team Care Type (e.g., Mental Health), the Team Assignment box displays with the option to assign staff members.

4. Once the patient is assigned, a confirmation message is displayed indicating the assignment was successful.

5. The assignment has been made and the assignment information now populates the View Team Assignments section. The patient will need a valid encounter with any member of the teamlet except the Administrative Associate to flip the Status of the PACT team assignment from PENDING to ACTIVE.

6. When a valid encounter is detected for the patient, the following occurred for the PACT assignment on the View Team Assignments section on the Patient Profile screen.
- Status Column now displays ACTIVE
- Start date column now displays the earliest encounter date
- Last Encounter column now displays the most current encounter
- Direct Care Provider now displays the most current encounter with the care provider

7. Assign a patient to another PACT Team at another facility within the same 3-digit station code. Repeat steps 1-4.

8. After the assignment process the patient has two PACT team assignments, one in ACTIVE status and the other in PENDING status. If an encounter is detected with a teamlet member of the PENDING team assignment, this team assignment will automatically flip to ACTIVE and the ACTIVE team assignment will become INACTIVE.

9. Multiple PACT team assignments per patient are allowed within PCMM Web, providing the following criteria is meet:
   - Each patient is allowed to have only one ACTIVE and one PENDING PACT assignment simultaneously within the same 3-digit station code to include all of the substations at any given time. The PENDING PACT assignment can only be generated after an ACTIVE assignment exists.
   - Each patient is allowed to have more than one ACTIVE PACT team assignments across the enterprise ONLY if there is an overall APPROVED Multi-PACT Request that is approved by all 3-digit stations holding a current ACTIVE PACT assignment as well as the station requesting the new PACT assignment.

**Encounter Date**

When assigning a patient to a new PACT team and the user has clicked the **Submit** button, PCMM Web will immediately search for any valid encounters in VistA within the last 60 days with any teamlet member to include PCP, Care Manager, Clinical Coordinator, and AP, if a patient is assigned to the AP. If an encounter is found, the Last Encounter date column on the Patient and Team Profiles will be updated to the date of the encounter and the patient’s PACT team Status “flips” automatically to ACTIVE.

**NOTE:** The Administrative Associate does not count since the staff member cannot enter encounters.

For an existing ACTIVE PACT assignment, if an encounter has occurred within the past 24 months with any member of the PACT, then the Last Encounter date column on the Patient and Team Profile will be updated. This date will update each time a patient has a valid encounter with one of his PACT teamlet members.

For a PENDING PACT assignment, if the assignment is in PENDING status and a valid encounter has been detected within the past 60 days, the Last Encounter Date and the Start Date of this team assignment will be set to the date of this encounter. This will cause the team Status to “flip” to ACTIVE.

**Unassign a Patient from a Team**

A patient can be unassigned from a team from the **Patient Profile** screen.
1. In **View Team Assignments** section of the Patient Profile screen, view the list of teams the patient is assigned or has been unassigned.

2. Click the **Unassign Patient from a Team** icon (red "X") in the **Actions** column.
   - **Note:** To view a description of the icon, move the mouse cursor over the icon.

3. Once clicked, the **Confirmation** warning box displays to verify whether to unassign the patient from the team. Click **OK** to display the **Team Unassignment for: Team name** dialog box or **Cancel** to return to the Patient Profile.

4. In the dialog box, select a value from the **Reason** drop-down menu.

5. Either accept today's default date or enter a new date in the **Effective Date** field. The effective date cannot be before the current assignment date and cannot be a past date.

6. Click **Submit** to save the data, or **Cancel** to return to the screen without saving the information.
7. Click **Submit** to display the *Login to VistA* with access/verify codes screen if not logged into VistA during the session. A user enters the access codes in the fields and click **Submit**. Click **Cancel** to return to the previous screens.

8. The system will display a confirmation message. Click **Close** to exit.

**Verify the unassignment:**

To view the unassigned patient to the team, navigate to the *Team Profile* screen. In the *View Patient Assignments* section with the Current Assignments radio button selected, the patient deleted no longer displays. Select *Historical Assignments* radio button and the following information displays:

- Status column displays CANCELED for the current team status
  - PENDING status goes to CANCELED
  - ACTIVE status goes to INACTIVE
- End date column displays the date and time the unassignment was made
- End Reason column displays the selected reason
- Actions column displays three options:
  - Revert assignment to active
  - View patient assignment history
  - Convert assignment to cancel. This action is permanent and cannot be undone

**Reassign a Patient to Team Role (Position)**

A user can reassign a Direct Care Provider associated with a patient.

1. In the *View Team Assignments* section of the *Patient Profile* screen, click the pencil icon in the Action column to display the *Reassign position for Team* box.
2. Select the calendar icon next to the **Effective Date** field to select a new date or accept the current default date. The effective date cannot be before the current assignment date and cannot be in the past.
3. In the **Assign to** drop-down, select the care provider to assign to a patient. Choose **Entire Team** if the patient is assigned to a team with a purpose of **Primary Care**, as they can only be assigned at the team level. If the patient is assigned to a team with a purpose other than Primary Care, the system will display current and active PCP or Associate Providers. Click **Submit**.
4. A confirmation message displays indicating that team role reassignment was successfully.
5. In the View Team Assignments section, the Direct Care Provider is updated to reflect the recent reassignment.
- To view the patient assignment history associated with any team, click the magnifying glass icon in the Action column to display the Timeline history window.

**Reassign a Patient to a Team**

On the Patient Profile screen in the View Team Assignments section, the user can reassign a patient to a team by utilizing the same Assign process. This applies to both PC and Non-PC teams.

**Note:** This process only applies to a single patient. To reassign more than one patient at a time, the user will use the Perform Batch Operations process that allows two or more patients to be moved.

**PC Teams ONLY** – Revert INACTIVE assignment to ACTIVE.

1. In the View Team Assignments section of the Patient Profile screen, click the revert icon in the Action column to display the Reassign position for Team box.

   **Figure 114** – Reassign a Patient from the View Team Assignment Section

   - PCMM Web will allow the user to revert an INACTIVE PACT assignment back to its previous ACTIVE status and retain the previous ACTIVE team information, if necessary. This will allow the assignment to the PACT team to bypass the qualifying encounter interrogation and to automatically revert back to Active. This functionality is only available for the latest INACTIVE assignment to the PACT team.
   - The ‘revert’ icon cannot be used to reactivate the latest INACTIVE assignment back to ACTIVE by removing the End Date if the patient was assigned to another PACT or HBPC team after the assignment was inactivated. A business rule prevents team assignments from overlapping. If another PACT/HBPC team was assigned after the inactivated team needing to be re-activated, then an overlap in the timeline history occurs and the system will prevent this action. For example, Team A unassigned on 8/1/15, then assigned to Team C on 9/1/15. Team A cannot be reverted because now the timeline has another entry for Team C and Team C’s Start Date is after Team A’s End Date. Team C’s Start Date cannot be removed from the timeline history table to allow the revert to occur.
   - The user is prompted to confirm the action to revert the INACTIVE assignment. Click Confirm.
3. A confirmation message is displayed. Click **Close** to display the *Patient Profile* screen.

4. The INACTIVE PACT assignment is now displayed as ACTIVE with all of the previous ACTIVE team assignment information. The End Date and End Reason have been removed and the Last Encounter date remains the same.

**Figure 115 - Revert Assignment to Active Box**

![Image of confirmation message]

**Figure 116 - Assigned Patient on the View Team Assignments Section**

**PC Teams ONLY** – Convert an INACTIVE assignment to CANCELED

PCMM Web will allow the user to convert the Status of an INACTIVE PACT assignment to CANCELED which will allow the user to then reassign the patient to the needed team and team role.

5. In the **View Team Assignments** section of the *Patient Profile* screen, click on the cancel icon under the **Actions** column. Since CANCELED assignments are not considered when interrogating for valid encounters on more recent assignments by PCMM Web, this will allow the user to reassign the patient to the needed PACT team and team role which will create an ACTIVE assignment. This functionality is only available for INACTIVE PACT assignments.

**Note:** If the encounter date for the INACTIVE assignment is more than 60 days old, then a new encounter would be required even if the assignment was converted to CANCELED and the patient reassigned.

6. Click the convert icon in the **Actions** column.
Figure 117 - Reassign a Patient to PC Team on the View Team Assignments Section

7. The user is prompted to confirm the action to convert the INACTIVE assignment. Click **Confirm**.

Figure 118 - Reassignment Confirmation Message

8. A confirmation message is displayed. Click **Close** to display the **Patient Profile** screen.

9. The INACTIVE PACT assignment is now displayed as CANCELED. The End date and End Reason have been updated and the Last Encounter date remains the same. Click the **Assign** button to reassign the patient to the needed team and team role.

Figure 119 - Reassign Patient to PACT Team on View Team Assignments Section

10. The CANCELED PACT assignment is now displayed as ACTIVE. The user selected to assign the patient to the AP instead of the PCP during this reassignment. The End date and End Reason have been removed and the Last Encounter date was updated with the most recent encounter date within the past 60 days. PCMM Web found the encounter date that was used for the previous assignment to the team and used it to flip this assignment to ACTIVE.
Non-PC Team assignments

The patient can have many other Non-PC team assignments. When assigned, the team assignment is automatically displayed as ACTIVE. Encounter dates are not used to activate Non-PC care types. These assignments will be either ACTIVE or INACTIVE.

Only the assigned MHTC for MH teams and Lead Coordinator for Transition and Care Management teams will be displayed in the Direct Care Provider column.

**Note:** For Transition and Care Management teams, the patient can ONLY be assigned to one of these teams per 3-digit station code to include all substations. Once a team has been created with this Care Type, the Care Type will no longer be displayed in the Care Type drop-down when creating a new team. The existing team for Transition and Care Management will be displayed in the List all Teams and Search for Team displays.

Mass Reassign/Unassign Patients

The mass transfer process enables a user to assign, reassign or unassign one or more patients from a team to another team, or a one position to another position on the same team.

- To transfer patients from one team to another team, the user **MUST** be on the **Team Profile** screen.
- To transfer patients from one position to another position on the same team (e.g. AP to Entire Team (PCP) / Entire Team (PCP) to AP / AP to AP), the user **MUST** be on the **Team Position Profile** screen that the staff members are explicitly assigned to before the moved is allowed. A validation error will occur when moving patients the same team on the **Team Profile** screen.
- Patients with a date of death (DOD) cannot be transferred.
- When transferring patients from one team to another team, the patients will be unassigned from the current team and can be viewed from the Historical Assignments in the **View Patient Assignment** section.
- The new team assignment for the patients will require a new encounter date with one of the new teamlet members before the new team assignment status will be ACTIVE. However, if the teamlet members on the previous team and the new team are staffed by the same members, the first encounter date is copied over to the new team assignment.
When transferring a patient from one active team to another active team with an APPROVED Multi PACT for the previous assignment, that status is transferred to the new assignment.

To reassign patients back to a team, navigate to Historical Assignments in the **View Patient Assignments** section either on the **Team Profile screen** or **Team Position Profile** screen.

**Reassign from the Team Profile Screen:**

1. In the **View Patient Assignments** section on the **Modify an Existing Team** screen, select **patient name** checkboxes to reassign and click the **Perform Batch Operations** button. The **Launch Batch Operations on Patient** page displays.

   ![Figure 121 - Mass Reassign on the Team Profile Screen](image)

   2. Click the **Mass Reassign** button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name.

   ![Figure 122 - Mass Reassign on the Launch Batch Operations on Patients Screen](image)

   3. A confirmation box displays. Click **Confirm** to continue or **Cancel** to exit the mass reassignment process. The **Search for Team** box displays.
4. Enter a team name in the **Name** field or click the **Search** button, to search for a team. Click either the **Entire Team**, **Associate Provider**, or **Medical Student** link to display the **Patient Batch Transfer/Assign** screen.

**Figure 124 – Entire Time Link Selected on the Search for Team Box**

5. Select a reason for the transfer from the **Reason** drop-down. The **Effective Date** and **Assign to** auto-populates. The **Assign to** displays the name of the PCP, AP, or Medical Student when patients are assigned.

6. Click **Submit** to complete the transfer.

**Figure 125 - Patient Batch Transfer/Assign Box**
7. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. Also, the user can verify that the Status has changed to Pending, requiring a new encounter date to make the new assignment active.

Verify the Assignment:

To view the newly assigned patients to the team, navigate to the Team Profile screen. In the View Current Assignments section, the Status is now Pending and will require a new encounter with a teamlet member to make the new assignment Active. Since the patients were assigned to the Entire Team, the Direct Care Provider column now displays the PCP’s name. Or, verify on the Team Position screen. In the View Team Assignments section, view the patients that were successfully assigned to the provider they were assigned.

Also, verify the historical trail of assignments for the patients are correct. The newly reassigned patients to the team will still have an entry for the previous assignment with the End date. In the View Patients Assignments section of a Team Profile or Team Position screen, select the Historical Assignments radio button. The dates for the reassignment should not overlap with the dates of the unassignment. All assignment dates should flow in a sequential pattern.

Transfer Patients from Positions on the Same Team:

8. In the View Patient Assignments section on the Modify an Existing Position screen, select patient name checkboxes to reassign and click the Perform Batch Operations button. The Launch Batch Operations on Patient page displays.
9. The team and the position information involved with the transfer are displayed above the patient list. Click the Mass Reassign button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name.
10. A confirmation box displays. Click Confirm to continue or Cancel to exit the mass reassignment process.
11. Since the transfer is between positions on the same team, enter the same team name that the patients are currently assigned in the Name field or click the Search button, to search for a team. Click either the Entire Team, Associate Provider, or Medical Student link to display the Patient Batch Transfer/Assign screen.
12. Select a reason for the transfer from the Reason drop-down. The Effective Date and Assign to auto-populates. The Assign to displays the name of the PCP, AP, or Medical Student when patients are assigned.
13. Click Submit to complete the transfer.
14. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. Also, the user can verify that the Status has changed to Pending requiring a new encounter date to make the new assignment active.

Mass Assignment From Historical Assignment:

If one or more patients are unassigned from the Team Profile screen or the Team Position Profile screen, a mass reassignment is possible through the Historical Assignments.
1. In the View Patient Assignments section on the Modify an Existing Team or Modify an Existing Position screen, select the Historical Assignments radio button.
2. Select the patient name checkboxes and click the Perform Batch Operations button.
3. The team and the position information involved with the transfer are displayed above the patient list. Click the **Mass Reassign** button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name.

4. A confirmation box displays. Click **Confirm** to continue or **Cancel** to exit the mass reassignment process.

5. Enter a team name in the **Name** field or click the **Search** button, to search for a team. Click either the **Entire Team**, **Associate Provider**, or **Medical Student** link to display the **Patient Batch Transfer/Assign** screen.

6. Select a reason for the transfer from the **Reason** drop-down. The **Effective Date** and **Assign to** auto-populates. The **Assign to** displays the name of the PCP, AP, or Medical Student when patients are assigned.

7. Click **Submit** to complete the transfer.

8. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. Also, the user can verify that the Status has changed to Pending requiring a new encounter date to make the new assignment active.

- When assigning patients from a Historical Assignment, the original historical entry for the patient will not be removed. This will allow the historical entry to remain, but the patient is moved to the Current Assignment list.

**Unassign Patients:**

A user can perform a mass unassignment of patients from the **Team Profile** screen or the **Team Position Profile** screen. Both can be completed in the **View Patient Assignments** section and applies for current assignments. The example below is from the **Team Profile** screen.

9. In the **View Patient Assignments** section on the **Modify an Existing Team** screen, select **patient name** checkboxes to unassign and click the **Perform Batch Operations** button. The **Launch Batch Operations on Patient** page displays.

**Figure 126 - Unassign Patients from the Team Profile Screen**

![Unassign Patients from the Team Profile Screen](image)

10. Click the **Unassign** button to unassign the patients to a team.

**Figure 127 - Unassign from the Launch Batch Operations Patients Screen**
11. A confirmation box displays. Click **Confirm** to continue or **Cancel** to exit the unassignment process. The **Unassign Selected Patients** box displays.

**Figure 128 – Unassign Confirmation Message**

12. Select a reason for the unassignment from the **Reason** drop-down.
13. Select the calendar icon next to the **Effective Date** field to select a new date or accept the current default date. The effective date can be a past date but cannot be future dated.
14. Click **Submit** to display the **Patient Batch Transfer/Assign** screen.

**Figure 129 - Unassign Selected Patients Box**

15. A message displays, indicating the patients are unassigned and to view the Alerts for the completion status and to verify the unassignment was made to the correct team.

- During the process of unassigning patients from the team, patients are automatically unassigned from any explicit assignments to a team position. The unassigned patients now display in the **Historical Assignments** on both the **Team Profile** screen and the **Team Position** Profile screen.
- If an unassigned patient was assigned to the PCP position or the Entire Team, the unassigned patient will be displayed in the **PCP Position Profile** screen as a Historical Assignment in the **View Patient Assignments** section.
- If an unassigned patient was explicitly assigned to an AP position, the unassigned patient will be displayed in the AP Position Profile screen as a Historical Assignment in the View Patient Assignments section.
- The user can verify that the Status of the team assignments have changed from Active assignments to Inactive assignments or Pending assignments to Canceled assignments along with the End date and time and the Reason.

### Auto Inactivation of a Patient from a Team

Patients must have been established and have active assignments to Primary Care teams to be eligible for Auto Inactivation. A patient's assignment status to a team will be inactivated automatically by the system in the following circumstances:

1. **Automatic inactivation due to inactivity:**
   - For each patient that has an active team assignment with a Care Type = Primary Care, the system will check when the patient had an encounter with any member of the PACT teamlet (i.e. the Primary Care Provider, Associate Provider, Nurse Care Manager, Clinical Associate) and will use that last encounter date as follows:
   - Patients must have active assignments to teams and be eligible to have their Last Encounter Date with that team recorded.
   - When a patient has been identified for auto inactivation, the selected date will be displayed in the View Team Assignments table.
     - Icons will display the amount of days before the patient will be auto inactivated:
       - If the Scheduled Inactivation Date is between 91 - 120 days from today, then the 120 day icon with the date will display.
       - If the Scheduled Inactivation Date is between 61 - 90 days from today, then the 90 day icon with the date will display.
       - If the Scheduled Inactivation Date is between 31 - 60 days from today, then the 60 day icon with the date will display.
       - If the Scheduled Inactivation Date is between 1 - 30 days from today, then the 30 day icon with the date will display.

### Figure 130 - Patient has been Identified for Auto Inactivation

- When a patient dies who is assigned to a team, the patient record is automatically moved from the Current Assignments list to the Staff Assignment Timeline list.
- If the patient has never had qualifying teamlet encounter within 8 months (i.e. 120 days before 12 months) from assignment to the team OR has had at least one previous teamlet encounter but not had another within 20 months (i.e.120 days before 24 months) from the active assignment date; the system will schedule the patient for automatic inactivation and send out a MailMan message.
• If the Scheduled Inactivation Date is within 120 days of the current date, PCMM Web will send out an alert stating that the patient will be automatically inactivated in 120 days unless an encounter occurs with a member of the PACT teamlet or is extended by a PCMM Web user. When the date of the scheduled inactivation arrives, and the patient is not extended or does not have a teamlet encounter, the patient will be automatically unassigned from his current PACT team and team roles. Assignments will then reflect a status of “Automatically unassigned due to Inactivity”.

• If Date Flagged for Inactivation had been previously recorded and a subsequent teamlet encounter is found before the team role and the team were unassigned; the assignment will remain active.

2. Automatic inactivation due to Date of Death recorded for a patient:

• When a Date of Death is recorded for a patient, he will be automatically unassigned from his current PC team and team role assignments with a status of Automatically unassigned due to death. The system will send out the Automatically Inactivated Death alert) stating that the Patient has been automatically inactivated.

• When a Date of Death is rescinded for a patient he will be automatically reassigned to his current PC team and team role assignments. The system will retrieve this data and populate the Position and Team Assignment Date on the PCMM Patient Team Assignment file and the Patient Provider Relationship (if needed) file. The date the patient was reassigned to the team will be recorded and displayed in PCMM web.

Manually Inactivate a Patient from a Team

A patient’s assignment status to a team can be inactivated by setting an inactivation date and reason. This can be done from three locations in the application.

From the Patient Profile Screen:

1. Click the View Team Assignments toggle link to display a list of teams to which the patient is assigned. Click the team name link. The Modify an Existing Team screen will display.

   ![Figure 131 - Manually Inactive a Patient from a Team](image)

2. Verify that the Show: Current Assignments radio button is selected (it is by default) and that Auto Inactivation is available.

3. Locate the Patient and click the patient name link. The Patient Profile displays. Select the green plus sign (+) displayed at the end of the Auto Inactivation date
for a team assignment. Verify that the Auto Inactivation date is equal to 183 days from the current date.

**Figure 132 - View Patient Assignments Section with the Green Plus Icon Selected**

4. The *Extend Patient Team Assignment Auto Inactivate* popup window will display. Choose a reason from the **Reason** drop-down list and click **Submit**, or **Cancel** to cancel.

**Figure 133 - Extend Patient Team Assignment Auto Inactivate Box**

**From the Team Profile Screen:**

1. Click the **View Patient Assignments** toggle link to display a list of teams to which the patient is assigned.
2. Verify that the **Show: Current Assignments** radio button is selected (it is by default) and that **Auto Inactivation** is available.
3. Select the **green plus sign (+)** displayed at the end of the Auto Inactivation date for a team assignment. The **Auto Inactivation** date will be equal to 183 days from the current date.

**Figure 134 - Manually Inactive a Patient by Selecting the Green Plus Icon**

4. The *Extend Patient Team Assignment Auto Inactivate* popup window will display. Select a reason from the **Reason** drop-down list and click **Submit**, or **Cancel** to cancel.
Figure 135 - Extend Patient Team Assignment Auto Inactivate Box

From the Position Profile Screen:

1. Click the View Positions & Staff Assignments link to display the From the Position List screen. Choose a Team Role and click on the Actions icon to display the Modify an Existing Position screen.

Figure 136 - Manually Inactivate a Patient from the Position Profile Screen

2. Click the View Patient Assignments (+) sign.
3. Verify that the Show: Current Assignments radio button is selected (it is by default) and that Auto Inactivation is available.
4. Select the green plus sign (+) displayed at the end of the Auto Inactivation date for a team assignment. The Auto Inactivation date will be equal to 183 days from the current date.
5. The *Extend Patient Team Assignment Auto Inactivate* popup window will display. Choose a reason from the drop-down list and click **Submit**, or **Cancel** to cancel.

### Multiple PACT Requests for Patient

**Overview**

Each patient must have only one assigned PACT within the VA system. When multiple PACT assignments are requested, a clinical decision (approval/denial) will be required. There can only be one active request per patient per 3-digit station at a time. Also, there can be multiple requests for the same patient at different stations at one time. A user can view all requested assignments for Multiple PC teams for a patient on the Patient Profile screen.

**Note:** Multiple PACT requests were previously known as Dual Assignment Request. Multiple PACT requests, MPACT, and Multiple PCP requests refer to the same process – all are interchangeable terms.

- If there are no active PC Assignments for this Patient at other stations, the multiple PACT request cannot be created.
- A multi-PACT request will be auto-generated while the assignment has a pending status.

When a patient is being assigned to a PACT team at the local station, the patient’s PACT assignments will be evaluated enterprise-wide to determine if an active PACT assignment exists in another 3-digit code station. If determined and the patient has one or more active PACT assignment(s) at other 3-digit code stations, then the system will automatically generate a Multiple PACT Request (MPACT).

- There can only be one pending request per patient per 3-digit code station at a time. The Multiple PACT request cannot be used to request an assignment within the same 3-digit code station.
- There can be multiple requests for the same patient for different 3-digit code stations at one time.
- In order to create/edit a Multiple PACT request for a patient, the patient must not have a Date of Death associated. If so, a Multiple PACT request will not be created.
- If there is a PENDING PACT assignment that turns to ACTIVE at another 3-digit station after a MPACT Request has an overall status of APPROVED for another 3-digit station, the MPACT Request **WILL NOT** change but the system will automatically generate a new MPACT Request for this new ACTIVE PACT assignment and add all stations that have ACTIVE PACT assignments to the Required PACT Approvers section of the MPACT Request.
MPACT Request Quick Summary

Below is a quick summary of a Multiple Pack Request process. Refer to the MPACT Request Process section for a detailed outline of how a MPACT is approved and conditional requirements.

1. A PCMM PACT assignment is entered on a Patient Profile. PCMM Web will immediately search to determine if an ACTIVE PACT assignment exists at another facility.
2. If there is an active PACT assignment located, the MPACT request is automatically generated and an actionable alert is sent to the TVC at local station. All alerts are sent within PCMM Web. Only a TVC with the “Clinical Approval by” role and a person class of RN, NP, or PA, will be allowed to approve/deny a MPACT request.
   • Note: Anyone can view a MPACT request on the Patient Profile once it is created.
3. Local station TVC selects the following options for the MPACT Request on the Patient Profile: (TVC will select the Reason first, enter Comments if needed on the Request and then select to Approve or Deny)
   • Reason: Medically Necessary or Permanent Relocation (Located towards top of request)
   • Comment: optional (This is provided to document any other information the TVC wants to share regarding the request)
   • Approve or Deny – Once the Approve or Deny button is selected, the request expands to display the approval/denial criteria. (Located at bottom of request.)
     o Clinical Decision by: select the clinician who approved the MPACT (i.e., doctor, TVC)
     o Comments: optional (This comment is for the approval/denial process - Required if MPACT Request is denied)
4. When the local station’s MPACT request is approved, actionable alerts are sent within PCMM Web to all TVC(s) at the other stations listed on the MPACT Request requiring action on request.
5. Receiving station(s) TVC selects the following options for the MPACT Request on the Patient Profile: (TVC will select to Approve or Deny)
   • Approve or Deny – Once the Approve or Deny button is selected, the request expands to display the approval/denial criteria. (Located at bottom of request.)
     o Clinical Decision by: select the clinician who approved the MPACT (i.e., doctor, TVC)
     o Comments: optional (Required if MPACT Request is denied)
6. All TVCs at all locations approve the MPACT Request. Informational alerts are sent within PCMM Web to all TVC(s) and PCMM Coordinator(s) at all stations involved with the request to state the MPACT Request is approved.
7. Pending PACT assignment status will advance to an Active PACT assignment status when a qualifying teamlet encounter is found.
8. If any of the approving stations deny the MPACT Request, the overall status of the MPACT Request will automatically change to DENIED and the PENDING PACT assignment associated with the MPACT Request will automatically be CANCELED.
   • All TVC coordinators on the request at every site except the site that denied the request.
   • All PCMM coordinators on request at every site except the site that denied the request.
9. There are three Escalation alerts that are sent regarding the MPACT Request. These escalation alerts are sent using Microsoft Outlook.
   a. 15 day Escalation Alert – Re-send alert to TVC that has not taken action on the request since the first alert was sent.
   b. 30 day Escalation Alert – Sent to VISN TVC notifying them that no action has occurred yet on the MPACT Request since the first alert was sent.
   c. 45 day Escalation Alert – Sent to National Coordinator notifying her that no action has occurred yet on the MPACT Request since the first alert was sent.

MPACT Request Process

Automatic Multiple PACT Request

1. The Multiple PACT request process starts when a patient is being assigned to a PACT team at the local station.
   - **Note:** Ensure to be logged into another station than the 3-digit station code of the patient’s existing ACTIVE PACT team assignment(s).

2. On the *Patient Profile* screen, expand **Multiple PACT Requests** section to view the overall Status of the request, the date the status changes, and the Receiving Station Name which will include the team name and focus. The Reason and Action columns will populate after the local TVC approves the request.

3. In the **View Team Assignments** section, the user can view the existing PACT assignment(s) and all other team assignments which will include ACTIVE and PENDING assignments for the patient. The user can assign a patient to a local PACT team in the process of assigning a patient to a team.

4. Click the **Assign** button to display the **Team Assignment** box.

5. Select the PACT team from the **Assign to** drop-down list and click **Submit** to complete the assignment.

6. If the system finds the patient is active at another station, The Multiple PACT Automatic Creation popup box will display. Click **Assign Anyway** to continue and complete the pending assignment, or **Cancel** to cancel. The **Attention** popup box will display. Click **OK**.

   **Figure 138 - Warning: Multiple PACT Automatic Creation Message**

7. The system creates a Multiple PACT request. The *Multiple PACT Request* section in the Patient Profile will contain a table that lists all of the requested assignments for the Primary Care teams and display the following fields:
   - **Status**
- **Pending** - Default when creating a new request, if all involved stations have not approved or denied the request.
- **Approved** - If all involved stations have approved the request.
- **Denied** - If any of the involved stations have denied the request or
- **Withdrawn** - If the station needing assignment cancelled the request

- **Status Date**
- **Receiving Station Name**
  - **Station Name** (Station #)
  - **Team name**
  - **Focus**
- **Reason**
  - **Medically Necessary** or **Permanent Relocation**
- **Action** to view the request details

**Figure 139 - Multiple PACT Request section on the Patient Profile Screen**

8. A confirmation message displays stating the patient was assigned successfully to the PACT team.

9. The system sends out alerts to all involved stations (i.e. those stations holding a current active PACT assignment or the station needing assignment). An **Informational Alert** is sent to the station needing assignment PCMM Coordinator for awareness and an **Actionable Alert** to the Station Needing Assignment TVC requesting to Approve OR Deny an existing Multiple PACT Request.
   - Only the facility’s Travelling Veteran Coordinator (TVC) and VISP TVC (and backups) can enter the approval/denial.
   - All involved stations must approve or deny the new pending request in order for the PACT assignment at the requesting station to be considered for activation.

10. The authorized user (TVC) opens the **Alerts** list (see the View Open Alerts List for a Current Station section), locates the correlating Actionable alert for the request, and clicks the **View/Action on Alerts** icon in the **Actions** column. The system will display the **Patient Profile** screen.

**Figure 140 - A MPACT Request for a Patient Alert**

11. Navigate to the **Patient Profile**.
12. On the **Patient Profile** screen, the PACT team assignment is now displayed in the **View Team Assignments** section. The Status is PENDING and depends on **two requirements before the assignment turns to ACTIVE**. The system will validate that each requirement has been met **before** the PACT assignment turns ACTIVE. An encounter date alone will change a PENDING PACT assignment associated with a Multi PACT Request.
   - **Requirement 1** – The patient must have a valid encounter date with a teamlet member of this team within the last 60 days.
- **Requirement 2** - The overall Status of the MPACT must be **approved**. The overall status is displayed on the patient’s profile in the **Multiple PACT Requests** section in the Status column. The MPACT Request will remain in PENDING status until **ALL** approvers listed in the Required PACT Approver table of the MPACT Request have provided an approval.

13. The **Multiple PACT Requests** section on the Patient Profile has been populated with the newly generated MPACT information. The following displays:

- **Status for the Request**
  - Pending (default when generating a new request and overall status if all involved stations have not yet approved or denied the request)
  - Approved (If **all** involved stations have approved the request)
  - Denied (If **one** of the involved stations have denied the request)
  - Withdrawn (If the station needing assignment cancelled the request)

- **Status Date**
  - As the MPACT request receives approvals/denials from other stations, the overall Status and Status Date will be automatically updated to reflect new Status/Status Date.

- **Receiving Station Name**
  - Station Name (Station#), Team name, Focus

- **Reason** (only populates after the local TVC selects it and approves the request locally)
  - Medically Necessary
  - Permanent Relocation

- **Action** to view the request details

### Approving Multiple PACT Request

14. Click the **Actions** icon (magnifying glass) to display the **Create or Edit Multiple PACT Request** screen. This screen will display:

- The Multi PACT Request form will auto-populate and display the overall status of the request in the **Status of the Request** field. This will be Pending until all approvals are received.
- **Request Entered On** - (user that generated the request)
- **Station Receiving Request** – (station that generated the pending PACT assignment request)
- **TVC's listed for that station** – (Station Name and Station Number)
  - This section will list the TVCs assigned to the selected station and will automatically populate users holding the “Traveling Veteran Coordinator” role (TVC) at the station. The TVC Phone and Email icon will display, if available.
- **Reason for Multiple PACT Request** (Medically Necessary or Permanent Relocation)
- **Comments** – (TVC may enter any additional comments, if needed.)
- The **Required PACT Approvals** section will include:
  - **Station** - This column will display all station names and numbers that have an ACTIVE PACT assignment and these stations will receive the Multi PACT actionable alert requesting approval/denial.
  - **TVC's** – This column will display all available TVCs for each station listed. It will display the TVC(s) name, phone number, and email address, if available.
  - **Status:**
    - Pending
- Approved
- Denied
- Withdrawn

Not Yet Submitted for Approval – Once a request is first submitted during the patient team assignment process, all other stations listed on the request form will display a Status of *Not Yet Submitted for Approval* to indicate the Multiple PACT Request has not been sent to the other stations for approval/denial. The Receiving Station TVC must approve or deny and select a reason before other stations are notified. Once the local TVC approves the request, the status will change for the local station to *APPROVED* and display as *PENDING* for all other stations listed on this request. Once all stations have approved this request, the Status column for all stations will display *APPROVED*.

- Status Date – This will display a date and time any action was taken for an existing PENDING Multiple PACT Request.
- Clinical Approval By
- Traveling Coordinator
- Comments (if any)
- Actions - Resend Alerts (Only available for Station Needing Assignment)

- Reason for Multiple PACT Request (Medically Necessary or Permanent Relocation)
- Comments – (TVC may enter any additional comments, if needed.)

15. Select the appropriate reason from the **Reason for Multiple PACT Request** drop-down field.
16. Enter any additional information or comments in the **Comments** field. This is optional, but helps to communicate between TVCs.

**Figure 141 - Create or Edit Multiple PACT Request Screen**
17. Click **Approve** to continue, or **Deny** to deny the requested approval. The status will be changed to **Approve**. The **Entered by** will be populated. The Approver selects an option from the **Clinical Decision by:** drop-down field, and comments may be entered.

18. Click **Submit** to continue, **Withdraw the Request** to withdraw, or **Cancel** to cancel the request. If submitted, the system changes the Status to **Approved** in the Patient Profile and sends an alert to the original station.

   - If the TVC denies the request, the pending PACT assignment request will be cancelled and closed with a reason of **Denied**.
   - If the Multi PACT Request is **Pending**, ONLY the Station Needing assignment TVC role can WITHDRAW the request. This will send an Informational alert to all station(s) TVC(s) and PCMM Coordinator(s) listed on the request, stating the request is no longer needed. The station needing the assignment can cancel the request as long as the overall status of the MPACT request is **Pending**. Even if the station needing assignment has approved the Multi PACT request that station can still cancel the request if its overall status is still **Pending**.
   - If a station has a pending assignment that flips to **Active** while a Multi PACT request still has an overall status of **Pending**, this station will be added to the Multi PACT request as a **Required PACT Approver**. The appropriate alerts will be sent to the appropriate staff members.
   - Once the overall status of a Multi PACT request changes from **Pending** to **Approved** or **Denied**, the request will be closed and no further changes are permitted.

19. A confirmation message displays. Click **Close**.

   **Figure 142 - Your Multiple PACT Request was Saved Successfully Attention Message**

   ![Attention Message]

20. Upon the TVC closing the Confirmation message, the system performs the following actions:

   - Updates the MPACT Request on the Patient Profile.
   - Displays the Status of the MPACT Request as PENDING since all other stations involved have not submitted approvals.
   - Updates the **Status Date** column to reflect the date and time the Station approved the request.
   - Displays the reason selected by the TVC for this request in the **Reason** column.
   - Sends Actionable alerts to all TVC(s) at the other stations listed on the MPACT Request in the ‘Required PACT Approvals’ section **requiring** action on this request.
Approve Station Process:

1. The TVC at the receiving station opens the Alerts list, locates the correlating Actionable alert for the request, and clicks the View/Action on Alerts icon in the Actions column. The system will display the Patient Profile screen.

   **Figure 143 - Multiple Pact Approval Alert**

2. The TVC opens the Multiple PACT Requests section and clicks the icon in the Action column for the corresponding record to display the Multiple PACT Automatic Creation box.

   **Figure 144 - Multiple Pact Requests with a Pending Status**

3. The TVC scrolls down to the Required PACT Approvals section.

4. The TVC has the option of resending the alert to the stations listed by clicking the Resend Alert button in the Actions column.

5. The TVC clicks Approve to continue (and may enter comments if desired), Deny to suspend the approval process. If Deny is selected, the TVC will be required to select a Reason and Date.
   - All involved stations must approve or deny the new pending request in order for the PACT assignment at the station to be considered for activation.
   - Once a request has been approved or denied – no further edits are permitted.
   - The other involved stations cannot edit any data. Stations can only approve or deny the request.
   - The TVC(s) must enter who made the clinical decision to Approve or Deny the request. This indicates if the TVC is approving the request or on behalf of someone else who authorized the approval. This drop-down list will include all PCMM Web users who hold the clinical approver permission and is required.

   **Figure 145 - Approving a MPACT on the Required Pact Approvals Section**

6. The TVC clicks Submit and the record is saved.

7. The request will be saved with an assignment status of Approved for the station approving the request. The overall status of the request will remain Pending until all
required approvals have been obtained. An Informational Alert will be sent to all TVC(s) at the other approving station(s) except the TVC’s station that just provided the approval.

- If the MPACT request is approved by all involved stations being asked to approve/deny the request, the status of the entire request will then be Approved. An information alert will be sent to all TVC(s) and PCMM Coordinators.

**If TVC Denies the Request:**

- The request will be saved with an assignment status of Denied. An Informational Alert will be sent to all TVC(s) and PCMM Coordinator(s) at the other approving station(s) except the TVC’s and PCMM Coordinator's station that just provided the denial.
- If the MPACT request is denied by one station within all the stations being asked to approve/deny the request, the status of the entire request will then be Denied. No further action on this request will be possible by any other approvers whose approval may be pending.

8. The system displays the details of the submitted request in the timeline on the **Patient Profile** screen.

- The system will track that all approvals needed are received. When they are, the assignment will be interrogated for activation. If a qualifying teamlet encounter has been recorded within the previous 60 days from the team assignment date; the assignment status will be changed from Pending to Active using the encounter date as the effective date for the activation.
- Once a MPACT Request is approved and in Approved status, it will be considered valid for 24 months using the Approval date from the last station to submit its approval on the request. If the patient is unassigned from that team and is re-assigned again or if the team itself is inactivated/re-activated in this time period, the earlier approval will be considered 'valid' during this 24 month period.
  - If the 24 month timeframe has passed and a patient is then unassigned from the team, a new MPACT Request is required.
  - If the 24 month timeframe has passed and the patient is still assigned to the team, the original MPACT Request is still considered valid.
- If a MPACT Request is still Pending 15 days after the request’s creation, the system will automatically generate an informational alert to all of the outstanding station approver(s) by sending an Outlook email to remind the recipient(s) to look at the PCMM Web Alerts and that action is needed.
  - If a MPACT Request is still Pending 30 days after the request’s creation, the system will generate an informational Escalation Alert to the VISN TVC coordinator of each station that has not responded to the MPACT Request by sending an Outlook email stating that a MPACT Request has been pending for 30 days and to look at the PCMM Web Alerts to take action on this request.
  - If a MPACT Request is still Pending 45 days after the request’s creation, the system will generate an informational Escalation Alert to the PCMM Web National Coordinator by sending an Outlook email stating that a MPACT request has been pending for 45 days and to look at the PCMM Web Alerts to take action on this request.
- If a date of death (DOD) occurs for a patient in the station needing assignment while a Multi PACT Request is in Pending status, the system will automatically unassign the patient from the pending assignment and the Multi
PACT Request will be WITHDRAWN. An information alert will be sent to all appropriate people.
  o If the Multi PACT Request already has a status of APPROVED or DENIED or WITHDRAWN, no changes will occur to those requests.
  o If a DOD occurs for the patient at one of the approving stations, the Multi PACT Request will not be affected. (The auto inactivation process of the active assignment at the other station will resolve this issue.)

Required PACT Approvals Station(s) Process

All other involved stations listed in the Required PACT Approvals section must approve or deny the new pending request in order for the PENDING PACT assignment at the Station Needing Assignment to be considered for activation. These involved stations will not be able to edit any data, they will only be able to approve or deny the request.

Each TVC at all other stations listed in the Required PACT Approvals section of the MPACT Request will review the Actionable alert requesting approval of a MPACT Request for a new PACT assignment for the patient.
  9. Navigate to the Patient Profile.
  10. In the Multiple PACT Requests, click the Actions icon (magnifying glass) to display the Create or Edit Multiple PACT Request popup screen.
  11. Navigate to the bottom of the request to access the Approve or Deny buttons. Note: The WITHDRAW button is no longer displayed since ONLY the Station Needing Assignment can WITHDRAW a request.
  12. Click Approve.
  13. The system automatically displays the Request Status and Entered By for this action.
  14. The status will be changed to Approve. The Approver selects a Clinical Decision by: , and comments may be entered if desired.
  15. Click Submit.
  16. A Confirmation message is displayed and the Patient Profile is displayed.
  17. That status of the MPACT has changed to APPROVED in the Multiple PACT Request section.
  18. The system performs the following actions:
    • Updates the MPACT Request on the Patient Profile:
      o Displays status as APPROVED since all stations involved have provided the necessary approvals.
      o Updates the date and time the MPACT request was approved Status Date column.
      o Displays the reason for the MPACT request in the Reason column.
    • Sends an Informational alert stating this station has just approved the request to all other stations on the MPACT Request except the station that approved it. Since there is no limit as to how many ACTIVE PACT assignments a patient can have with an APPROVED MPACT Request for each PACT assignment, there could be several stations listed as approving stations on the request. This Informational alert will be sent each time a station approves until all approvals are received from all stations involved on the request.
    • Sends Informational alerts to all TVC(s) and PCMM Coordinator(s) at all stations involved with the request stating that all approvals have been received and the MPACT Request has been approved.
The PENDING PACT assignment associated with this APPROVED MPACT Request is still in PENDING status. Even with an APPROVED MPACT Request, the assignment will not flip to ACTIVE until a valid encounter with a teamlet member of the team the patient is assigned is detected by the system within the past 60 days.

19. The TVC at the original station the request was submitted can view the PENDING PACT assignment on the Patient Profile screen and enter an encounter to flip this assignment to ACTIVE because of the APPROVED MPACT Request.
   - **Note:** The patient could have already had an encounter with a teamlet member and the PENDING PACT assignment would have flipped simultaneously to ACTIVE when the overall Status on the MPACT Request changed to APPROVED.

20. The patient’s PENDING PACT assignment is now ACTIVE after the system verified the two requirements needed to flip this PACT assignment to ACTIVE. Those requirements are:
   - An overall APPROVED MPACT Request
   - A valid encounter with a teamlet member in the past 60 days

21. When the PACT assignment flips from PENDING to ACTIVE, the **Start Date and time** will update to reflect the date of the encounter which is the date the team assignment starts as ACTIVE.

22. The MPACT Request process to allow a patient multiple PACT assignments throughout the enterprise has been completed successfully.

### Permanent Relocation Process:

- If the TVC at the station needing assignment selects **Permanent Relocation** as the reason for the Multi PACT Request, it is to assist the patient with an easy transition to the patient’s new station. Once overall approval is received by the station needing assignment, the following alerts will be sent:
  - An informational alert will be sent to all TVC(s) on the request stating the relocation has completed and the request has been WITHDRAWN.
  - An actionable alert will be sent to all PCMM Coordinator(s) on the request stating the relocation has completed; that all Active PACT assignments need to be unassigned at each of the approving station(s); and the request has been WITHDRAWN.

### Assign a Non-VA Provider to Patient

A user can assign a Non-VA Provider from the Patient Profile.

1. From the Patient Profile screen, click the **View Non-VA Providers** toggle link to display a list of Non-VA Providers the patient is assigned or has been unassigned.
2. Click the **Assign** button to display the **Assign a Non-VA Provider to a Patient** screen.
3. Click the **Search** button to display the *Search for Non-VA Provider* window.

**Figure 147 - Assign a Non-VA Provider to a Patient Screen Searching for a Provider**

4. Select the type of Non-VA Provider from the **Category** drop-down menu. Available options are:
   - DoD
   - Private Sector
   - Veteran's Choice
   - Community Nursing Home
   - Veteran State Home

5. Enter the last name for the Non-VA Provider in the **Name** text box.
6. Enter the phone number associated with the Non-VA Provider in the **Phone** text box.
7. Enter the email address associated with the Non-VA Provider in the **Email** text box.
8. Enter the practice name associated with the Non-VA Provider in the **Practice Name** text box.
9. Enter the city associated with the Non-VA Provider in the **City** text box.
10. Select the state associated with the Non-VA Provider in the **State** drop-down menu.
11. Click **Search** to display search results. The Results list will display the Provider Name, Category, Role, Specialty, Practice Name, Phone Number, Email, and Address. The list can be sorted by any column or narrowed by using a filters. If the Non-VA Provider has an email listed, click the e-mail icon that corresponds to the provider name to send a message.
12. Click the **name** link to assign the Non-VA Provider to the Patient and to display the *Assign a Non-VA Provider to a Patient* screen.

**Figure 148 - Search for Non-VA Provider Screen**
13. Select the Non-VA Provider type in the **Category** drop-down menu. After the Category is selected, the Non-VA Practice associated displays and is automatically selected. For the Private Sector and DoD Categories, a user has the option to keep the preselected Non-VA Practice or to select the No Practice Selected radio button.

14. Select the role type from the **Role** drop-down list.

15. Select the specialty from the **Specialty** drop-down list.

16. Click the **calendar** icon next to the Assignment Date field to select the date and time the assignment will be effective.

17. Click **Submit** to assign the patient to the Non-VA Provider.

**Figure 149 - Submitting the Patient Assignment to the Non-VA Provider**

18. A confirmation message will appear if the assignment was successful. Click **OK** to continue.

**PACT Panel Placement**

The PACT Panel Placement is used as a communication tool for coordinators within the same 3-digit station codes to assist with the transition of teams within the same facility or between facilities and coordinate a change in the assigned patient’s PACT team.

This request is used for communication purposes only for the user to facility information regarding the patient’s PACT team assignment and must be used within the same 3-digit code station. There can be multiple requests for the same patient for different divisions at one time. The patient must have an active PACT team assignment at one station before this function can be performed.

1. Expand the **View Panel Placement Requests** section from the **Patient Profile** screen.

2. The following columns will display:
   - Status
   - Status Date
   - Station Name
   - Group
   - Team
   - Requester
   - Effective Date
   - Actions
3. To create a PACT Panel Placement request, click the **Create a Request** button. The **Create Panel Placement Request** popup box will display.

**Figure 150 - View Panel Placements Request with the Create a Request Button Selected**

<table>
<thead>
<tr>
<th>Status</th>
<th>Status Date</th>
<th>Station Name</th>
<th>Group</th>
<th>Team</th>
<th>Requester</th>
<th>Effective Date</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Create a Request</td>
</tr>
</tbody>
</table>

4. Enter some text to filter to search for a station in the **Search Receiving Station** text field.
5. Select the station in the **Receiving Station** drop-down list. (required)
6. Select the group number in the **Group** drop-down list.
7. Select the team for the panel placement request in the **Team** drop-down list.
8. Select a reason for the panel placement request in the **Reason** drop-down list. (required)
9. Select the type of requester in the **Requester** drop-down list. (required)
10. Select the calendar icon next to the **Effective Date** field to change the current date and time. Past dates are not allowed.
11. Add any additional information in the **Comments** text field.
12. Click **Submit**. The **Attention** popup box will display with a success message. Click **Close**.

**Figure 151 - Create Panel Placement Request Screen**

13. The record will appear in the **View Panel Placement Requests** section with a status of **Pending**.
14. A user can edit the request while still in a Pending status by clicking the icon in the **Actions** column. The **Edit Panel Placement Request** popup box will display. Edit fields, if desired.
15. Click **Submit**. The Attention popup box will display with a success message. Click **Close**.
16. An alert will be sent to the user of the site that generated the request and the user of the site that is listed on the request stating that a request was created. This alert will be sent from the system to each recipient each time a PACT Panel Placement Request is created or when the Team or Station on the request is updated.
17. The **View Panel Placement Request** section is populated on the Patient Profile. The Panel Placement Request can be updated by clicking the **Actions** column. New alerts are sent only when updating the group or team for the request. This will trigger new alerts to both facilities. **Only** updates to the team or group will trigger a new alert.
   - *Move/Relocate* request: if the record contains a Move/Relocate reason for the request, the system will automatically unassign the patient from the active team assignment at the first station and creates the Pending assignment at the new station when an encounter date occurs for the Pending assignment at the new station.

**STAFF MANAGEMENT**

**Search for VA Staff**

A user can quickly search for a VA staff member using the menu option.
1. Select **Staff > Search for VA Staff** from the main menu to display the Search for Staff window.

   **Figure 153 - Search for VA Staff Menu Option Selected to Manage VA Staff**

2. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search.
   - A terminated staff member is shown as “Separated” in the search results.
   - Total FTE column includes the sum of team assignments associated with the staff member.
3. Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member to narrow the search results. (E.g. Smith,J or Smith,Jo or Smith,Jones)
4. Click **Search** to display a list of staff names results. Click **Cancel** to cancel the search.
5. Click the icon in the **Select** column to view the staff member’s profile. The **Staff Profile** screen will display.

**Figure 154 - Search for Staff Box to Manage VA Staff**

6. The following information displays on the **Staff Profile** screen:
   - Name, Title, Phone, Pager, and Email.
   - If the Staff Member has an email, click the email icon to email the VA staff member.
   - Expand the **View Team Assignment** toggle link to view a list of patient assignments. When selected, the **Historical Assignments** option displays patients previously assigned to team. To revert to the current list, select the **Current Assignments** option. To filter through the patient list, use the text box provided.
   - Click on a **team name** link. The **Modify an Existing Team** page will display and the user has the option to modify fields and options.

**Figure 155 - Modifying a Staff Member on the Staff Profile Screen**
If the system cannot find a staff member:

- If the system cannot find a record, a message will display in the Search for Staff window. Click the Find in VistA button to search for the staff member in VistA that is not listed in the PCMM Web Search results list. VistA requires at least two letters of the last name to perform a search. Enter the search criteria and select the Find in VistA button.
- Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member to narrow the search results. (E.g. Smith,J or Smith,Jo or Smith, Jones)
- The PCMM Web VistA staff search will now display all staff members with the same last name in the search for staff results table even if the SSN field is blank in VistA.
- The screen will refresh with the VistA results display. Click the icon in the Select column that corresponds to view the staff member’s profile.

Remove or Unassign Staff from a Team Role (Position)

A user can remove staff from a team role from the Position List screen. The associated team must have an active status.

From the Team List screen:
1. From the main menu, click Teams > List All Teams or Teams > Search for a Team. Click on the team name link.

   Figure 156 - List All Teams Menu Option Selected to Remove or Unassign a Staff

   ![List All Teams Menu Option](image)

2. From the Modify an Existing Team screen, click View Positions and Staff Assignments. The Position List page will display.
Figure 157 - View Positions and Staff Assignments Link Selected to Remove or Unassign a Staff from a Team Role

Alternatively, from the Position List page, click the icon in the Actions column. Click the Manage Staff button in the Current Staff Assignments section.

3. Click the name link in the Staff Name column to display the Staff Information page.
4. Click the Unassign button to remove the staff member name and profile from the team role.

Figure 158 – Unassigning a Staff from a Team Role

5. A box will display, indicating whether to unassign the staff member. Click Confirm to continue or Cancel to cancel. The Staff Information screen displays.

Figure 159 - Confirmation of Unassignment of Staff from the Team Role Message
6. Click the calendar icon next to **Unassignment Date** field to change the unassignment date (current date and time is displayed by default).
7. Choose an **Unassignment Reason** from the drop-down list.
8. Click the **Submit** button to confirm the unassignment, or **Cancel** to cancel.
9. When the unassignment occurs, the unassignment date/status/reason will be captured in History with who requested the change and when.

**Note:** If the team role is a preceptee that has a preceptor assigned, the team role may not be de-staffed until the preceptor relationship is terminated. A user will be presented with a message indicating the team role has a preceptee and cannot be de-staffed without first unassigning the preceptee.
Reassign or Modify Staff Assignment

A user can reassign or change staff assignments from the Position List screen. The associated team must have an active status.

From the Team List screen:

1. From the main menu, click **Teams > List All Teams**.

   **Figure 160 - List All Teams Menu Option Select to Reassign or Modify a Staff Assignment**

2. Click the icon in the **Position** column for the desired team to display the **Positions List** page. The team must be active.

From the Modify an Existing Team screen:

3. From the main menu, click **Teams > Search for a Team**. Click on the **team name** link.
4. From the **Modify an Existing Team** screen, click **View Positions and Staff Assignments**. The **Position List** page will display.

Alternatively, from the **Position List** page, a user can click the icon in the **Actions** column. Click the **Manage Staff** button in the Current Staff Assignments section.

5. Click a name link in the **Staff Name** column to display the **Staff Information** page.
6. Click the **Reassign** button. A Confirmation dialog box displays to confirm the reassignment of the staff member. Click **Confirm** to continue and display the **Search for Staff** dialog box or **Cancel** to exit.
7. A box will display, indicating whether to unassign the staff member. Click **Confirm** to continue or **Cancel** to cancel. The **Staff Information** screen displays.

**Figure 162 - Reassignment Confirmation Message**

8. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Click **Search**. If the system cannot find the staff member, click the **Search VistA** button.

9. Click the icon in the **Select** column. The **Staff Information** dialog box will display. A user can start the search process again to choose another staff member. Click the **Search Staff** button to proceed with this process.

**Figure 163 - Searching for Staff Member on the Search for Staff Box**
10. Click the calendar icon next to the **Effective Date** field (current date and time is displayed by default).
11. Enter the **FTE** (current FTE is displayed by default).
12. Click the **Submit** button to confirm the reassignment, or **Cancel** to cancel. The *Modify an Existing Position* screen will display and the new Current Staff member's information will display.

   **Figure 164 – Defining the Effective Date for the Reassignment**

![Image of the staff information screen with highlighted submit and cancel buttons](image)

13. When the reassignment occurs, the reassignment date/status/reason will be captured in History with who requested the change and when.

   **Note:** If the team role is a preceptee that has a preceptor assigned, the team role may not be de-staffed until the preceptor relationship is terminated. A user will be presented with a message to indicate the team role has a preceptee and cannot be de-staffed without first unassigning the preceptee.

### Create a Non-VA Provider

A user can create a Non-VA Provider that provides Non-VA Care to the patient through the VA. Non-VA Care consists of three categories: Veteran’s Choice, Community Nursing Home, and Veteran State Home.

A user can create a new Non-VA Provider from the *Patient Profile* screen.

1. Expand the **View Non-VA Providers** section on a *Patient Profile* screen and click the **Assign** button to display the *Assign a Non-VA Provider to a Patient* screen.

   **Figure 165 - View Non-VA Providers Section with the Assign Button Selected**

![Image of the view non-VA providers section with assign button highlighted](image)
2. Click the **Search** button next to **Provider** to display the **Search for Non-VA Provider** screen.

![Figure 166 - Searching for a Provider](image)

3. User must first search for a Non-VA Provider before one can be created. Enter the search criteria and click the **Search** button. If the Non-VA Provider is not found in the system, the **Create New Provider** button displays. Click the **Create New Provider** button to display the **Assign a Non-VA Provider to a Patient** screen.

   **Note:** Only after clicking the **Search** button, will the **Create New Provider** button display. This enables a user to verify first, if the Non-Provider exists before a new one is entered in the system.

![Figure 167 - Search for Non-VA Provider Screen with the Create New Provider Button Selected](image)

4. The **Search** button displays to allow the user to search for a Non-VA Provider during the creation process.

5. Select the Non-VA Category type from the **Category** drop-down. Options are:
   - Community Nursing Home
   - DoD
   - Private Sector
   - Veteran State Home
   - Veteran’s Choice
**Name Section:**
6. Enter the last name of the Non-VA Provider in the **Last Name** text box.
7. Enter the first name of the Non-VA Provider in the **First Name** text box.
8. Enter the middle name of the Non-VA Provider in the **Middle** text box.
9. Enter the suffix of the Non-VA Provider in the **Suffix** text box.

**Address section:** (only displays for the DoD Category)
10. Enter the address of the Non-VA Provider in the **Address Line 1, Line 2, and Line 3** text box(es).
11. Enter the city where the Non-VA Provider resides in the **City** text box.
12. Select the state where the Non-VA Provider resides in the **State** drop-down.
13. Enter the Zip Code where the Non-VA Provider resides in the **Zip** text box.
14. Select a role from the **Role** drop-down list (required) and select a specialty from the **Specialty** drop-down list.
15. Click the **Search** button to create or assign a Non-VA Practice to a Non-VA Provider. Click the **name link** to assign a Non-VA Practice.
16. Select the calendar icon to indicate the assignment date.
17. Click the **Search** button to assign a Coordination Team. This option available for all Non-VA Provider Categories expect for DoD.
18. Click **Submit** to save the information and display the Non-VA Provider Information screen. The new provider will be listed. Or click **Cancel** to display a dialog box that asks to confirm the cancelation and warns that no information will be saved.

**Figure 168 - Assign a Non-VA Provider to a Patient Screen**

---

**Search for a Non-VA Provider**

A user can search for a Non-VA Provider in the PCMM Web system in order to view and update provider information.

1. Select **Non-VA Provider> Search for Non-VA Provider** from the main menu to display the **Search for Non-VA Provider** window.
2. Select a Non-VA Provider type from the Category drop-down list. The following are available:
   • DoD
   • Private Sector
   • Veteran’s Choice
   • Community Nursing Home
   • Veteran State Home
3. Enter the full name for the Non-VA Provider in the Name text box.
4. Enter the phone number associated with the Non-VA Provider in the Phone text box.
5. Enter the email address associated with the Non-VA Provider in the Email text box.
6. Enter the practice name associated with the Non-VA Provider in the Practice Name text box.
7. Enter the city associated with the Non-VA Provider in the City text box.
8. Select the state associated with the Non-VA Provider in the State drop-down menu.
9. Click Search to display search results. The Results list will display the Provider Name, Category, Roles, Specialties, Practice Name and Provider Contact information. The list can be sorted by any column or narrowed by using a filters. If the Non-VA Provider has an email, click the e-mail icon that corresponds to the provider name.
10. Click Cancel to cancel the search.
11. Click the name link to view or modify the Non-VA Provider on the Non-VA Provider Profile screen.

**Modify an Existing Non-VA Provider**

Users can edit Non-VA Provider records already listed in PCMM Web.
1. Locate the Non-VA Provider's information using the Search for Non-VA Provider window or from the View Non-VA Providers section from a Patient Profile screen.

2. Click the provider name link listed in the Provider Name or Name column.

   **Figure 171 – Search for a Non-VA Provider with the Name Link Selected**

3. The Non-VA Provider Profile screen will display. Modify any or all of the fields shown.

   **Figure 172 - Non-VA Provider Profile Screen**

4. Click the View Patient Assignments toggle link at the bottom of the screen to view a list of patient assignments. When selected, the Historical Assignments option displays patients previously assigned to team. To revert to the current list, select the Current Assignments option. To filter through the patient list, use the text box provided.
5. Click the **View Practices** toggle link at the bottom of the screen to view a list of practice assignments. The View Practices section includes the Practice Name, Phone Number, and Email Address and an Action column. If the Non-VA Provider has an email, click the email icon to email the staff member.
   - **To delete a Practice from the Non-VA Provider,** select the **Delete** icon in the Action column.
   - **To add a new Practice to the Non-VA Provider,** click the **Add** button to display the Search for Non-VA Practice box. Enter the appropriate search criteria and then select the Non-VA Practice.

**Figure 174 - View Practices Section to View a List of Practice Assignments.**

6. Click **Submit** to continue, **Cancel** to cancel.

7. The **Non-VA Provider Profile** screen displays, with the changes saved in the record

### Create a New Non-VA Practice

A user can create a Non-VA Practice, associated with a Non-VA Provider to provide care to the patient, outside the VA. A user can create a Non-VA Practice when searching for a Non-VA Provider to assign to a Patient, or from the main menu.

1. Select **Non-VA Providers > Search for Non-VA Practice** from the main menu to display the **Search for Non-VA Practice** screen.

**Figure 175 - Search for Non-VA Practice Menu Option Selected to Create a Non-VA Practice**
2. Click the Search button or enter the search criteria for a Non-VA Practice. **Note:** To avoid duplications of practices, a user must search for an existing Non-VA Practice before being allowed to create a new one. If the practice is not available when the search criteria are returned, a user can then create the Non-VA Practice.

3. If a Non-VA Practice is unavailable, click the **Create New Practice** button to display the **Create a Non-VA Practice** screen.

**Figure 176 - Search for Non-VA Practice Screen with the Create New Practice Button Selected**

4. Enter the Non-VA Practice in the **Name** text box.
5. Enter the phone number in the **Phone** text box.
6. Enter the fax number in the **Fax** text box.
7. Enter the main email address for the Non-VA Practice in the **Email** text box.
8. Enter the address(es) for the Non-VA Practice in the **Line 1**, **Line 2**, and **Line 3** text boxes.
9. Enter the city in the **City** text box.
10. Select the state in the **State** drop-down menu.
11. Enter the ZIP code in the **Zip Code** text box.
12. Click **Submit** to continue, **Cancel** to cancel.

**Figure 177 - Create a Non-VA Practice Screen**
Update an Existing Non-VA Practice

Users can edit Non-VA Practice records in PCMM Web.

1. Locate the Non-VA Practice using the Search for Practice window or from the View Practice section of the Non-VA Provider Profile screen.

**Figure 178 - Search for Non-VA Practice Menu Option Selected to Update an Existing Non-VA Practice**

2. Click the provider name link listed in the Provider Name or Name column.

**Figure 179 - Search for Non-VA Practice Screen with Practice Selected**

3. The Non-VA Practice Profile screen will display. Modify any or all of the fields shown.

4. Click Submit to continue, Cancel to cancel.

**Figure 180 – Non-VA Practice Profile Screen**
ROOMS MANAGEMENT

Create a Room

To Create a Room:

1. Select Create a Room from the Rooms drop-down menu to display the Create a New Room screen.

   Figure 181 - Create a Room Menu Option

   - Note: Or a user can navigate to the Create a New Room screen by following this path: Rooms drop-down menu > List All Rooms > List All Rooms screen > Create a Room button.

   Figure 182 - Room List Screen with the Create a Room Button Selected

2. Enter a unique room number in the Number field. This is an alphanumeric field.
3. Enter a room name in the Name field.
4. Select a room type. (Exam is selected by default). For each selection, a description of the room type is displayed.
5. Enter an expected FTE value. It must be greater than 0.00 and it cannot be greater than 1.5.
6. Enter a room description in the Description field.
7. Accept the default room status of Active, or select Inactive. A user can edit the room information later.
8. Click Submit to save the data and display the Rooms List page. The new room will be listed.
Manage Rooms

PCMM Coordinators are able to manage rooms using the *List All Rooms* screen.

To Manage Rooms:

1. Select **List All Rooms** from the **Rooms** drop-down menu to display the **Rooms List** screen.

2. For each room, the list will display the:
   - Total Exam Rooms (Active)
   - Total Interview Rooms (Active)
   - Total Rooms (Active)
   - Room Number
   - Room Name
   - Room Type (examination, interview, or both)
   - Room Description
   - Expected FTE Usage (0.01 – 1.00)
   - Actual FTE Usage
   - Available FTE for Assignment (determined by system)
   - Room Status (Active/Inactive)
The room list will initially be displayed in order by Number and will include all rooms. The list can be sorted by any column or narrowed by applying filter values for Type and Status. A user can perform the following tasks on this screen, depending on the user role:

- Create a room by clicking the **Create a Room** button.
- Modify a selected room by clicking the **Room Name** link.

**Figure 185 - Room List Screen to Create or Modify a Room**

**Search for a Room**

1. Select **Search for Room** on the **Rooms** drop-down menu on the PCMM Web home page to display the **Search for Room** dialog box.

**Figure 186 - Search for Room Menu Option**

2. Enter all or part of the room desired in the **Number** field and click **Search** to display a list of rooms below the **Search** button. Alternatively, leave the Number field blank and click the **Search** button to display a list of all rooms for that station.

3. The **Search for a Room** dialog box will display. The following columns are displayed in the room list table:
   - Number
   - Name
   - Description
   - Status
   - Select

4. Click the icon in the **Select** column for the desired room to display room information in the **Modify An Existing Room** screen. Alternatively, click **Cancel** to cancel out of the search.
Modify an Existing Room

To Modify an Existing Room:

1. Search for a room to modify from the Search for Room dialog box or from the Rooms List screen.

2. On the Modify an Existing Room screen, modify the following information for that room:
   - Number
   - Name
   - Type
   - Expected Examination Usage FTE
   - Expected Interview Usage FTE
   - Description
   - Status (Active/Inactive)
   - Every field value except for Room Name and Description is required and must contain a value.

3. Click Submit to save the information and display the Room List screen.

From this screen a user can also view the Active Team Assignments and the Inactive/Historical Team Assignments for the room.
Assign a Room to a Team

1. From the *Modify An Existing Room* screen, click the **View Active Team Assignments** toggle link to view a list of team and room assignments.
2. Click **Assign Team** to display the **Team Assignment** dialog box.

3. Click **Search** to display the **Search for Team** dialog box.
4. Enter all or part of the team name desired in the **Name** field and click **Search** to display a list of teams. Alternatively, leave the **Name** field blank and click the **Search** button to display a list of all teams.

5. Select the **team name** link in the Name column to return to the Team Assignment dialog box and populate the **Team** field.

**Figure 191 - Searching for a Team to Assign to a Room**

![Search for Team](image)

6. Enter an **Actual FTE** value for the exam, Interview, or both rooms. The FTE value must be greater than 0.00 and it cannot be greater than 1.5. If the FTE value entered for the team assignment is greater than the FTE value assigned to the room, an error message will display.

7. Click **Submit** to save the information and display the **Modify an Existing Room** screen.

**Figure 192 - Actual Exam FTE Defined for the Team Assignment**

![Team Assignment](image)

8. Click the **View Active Team Assignments** toggle link to view a list of teams and room assignments. The new team and room assignment is listed.

**Figure 193 - Newly Assigned Room to the Team**

![View Active Team Assignments](image)
9. Unlink a team from the room assignment, or change the actual FTE value for a team’s use of the room by clicking the X icon in the Actions column that corresponds to the team to unlink.

**Figure 194 - Red X Icon Selected to Unlink a Team from a Room**

10. An Are you sure dialog box will display. Click **Confirm** to continue; **Cancel** to cancel.

**Figure 195 - Confirmation to Unlink the Team from the Room Message**

11. Click the **View Inactive/Historical Team Assignments** toggle link to view the team’s assignment record.

**Figure 196 - Viewing Team Assignment Records in the View Inactive/Historical Team Assignments Section**

12. To change the Actual FTE value for a team’s use of the room, click the **pencil icon** in the Actions column that corresponds to the team’s FTE.

**Figure 197 - Action Icon Selected to Change the Actual FTE Value**
13. The Change Actual Assignment FTE dialog box will display. Enter an Actual FTE for the team.

Figure 198 - Change Actual Assignment FTE box

![Change Actual Assignment FTE dialog box]

14. Click **Submit** to continue, **Cancel** to cancel.
15. If the FTE value entered for the team assignment is greater than the FTE value assigned to the room, an error message will display. Click **Close** and enter a valid FTE value.
16. Click **Submit** to save the record.

**View Room Assignments for a Team**

1. From the *Modify an Existing Room* screen, click the **View Active Team Assignments** toggle link to view a list of team and room assignments. The following information will display:
   - Team
   - Care Type
   - Focus
   - Station
   - Actual FTE Usage
   - Assignment active since
   - Actions (Use this column to either unlink the team from the room assignment or change the Actual FTE value for a team’s use of the room.)
   - The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus.

Figure 199 - View a Room Assignment on the View Active Team Assignments Section

![View Active Team Assignments]

2. Click the **View Inactive/Historical Team Assignments** toggle link to view a list of past team and room assignments. The following information will display:
   - Team
   - Care Type
• Focus
• Station
• Actual FTE Usage
• Assignment Start Date
• Assigned End Date
• The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus.

Figure 200 - View Inactive/Historical Team Assignments Section

GROUP MANAGEMENT

Create a New Group

Utilizing groups is an administrative tool that allows the user to group similar teams together, such as team purpose or location. A user is able to create a new group and add the group information to the PCMM Web system. This adds the group name to the Group List screen and allows a user to search for the group information.

1. From the Groups drop-down menu, select Create a Group to display the Create a New Group screen. A user also can display this screen by clicking the Create a Group button on the List Groups screen (Groups > List All Groups > List Groups).

   Figure 201 - Create a Group Menu Option

2. Enter a name for the group. The system will ensure that the new name is unique across all stations with the same three-digit code as the currently logged-in station. The system will display an error message if a duplicate group name is found. If so, please enter a new unique group name.
3. Enter a description of the group in the Description field.
4. Enter a Primary Point of Contact name.
5. Enter a Primary Point of Contact phone number.
6. Enter a Primary Point of Contact city and state.
7. Click Submit to save the group information and display the Groups List screen. The new group will be listed with a current status of Active. Click Cancel to return to the Groups List screen without saving any data.
The system will display an error message for any required field that is not completed. Complete the fields before re-submitting the group information.

The system will validate the values of the required fields for Name and Primary Point of Contact Email to ensure proper entry.

A Current Status field will automatically populate with an Active status once a group is created and will be displayed on the “Modify an Existing Group” screen. A user can also inactivate a group.

**Figure 202 - Create a New Group Screen**

**View Groups List**

A user can view a station-level summary list of all active groups. This allows a user to view or modify group information, email a group’s primary point of contact, view information about a group’s teams, and inactivate a group.

1. From the Groups drop-down menu, select List All Groups to display the Groups List screen.

**Figure 203 - List All Groups Menu Option to View Group Lists**

2. For each group listed for that station, the list will display:
   - Name
     - View or modify group information by clicking a name link in the Name column. This will display the Modify an Existing Group screen.
   - Description
   - Primary Point of Contact Name
- Primary Point of Contact Phone
- Primary Point of Contact E-mail
  - Email a group’s primary point of contact by clicking the envelope icon in the **Primary Point of Contact** E-mail column.
- Teams
  - A user can view information about teams assigned to a group by clicking a **team name** link in the **Teams** column. This will display the **Modify an Existing Team** screen.
- Status (Active or Inactive)
- Actions
  - Inactivate a group by clicking the icon in the **Actions** column. Note that once a group is inactivated, all teams assigned to the group are unassigned from the group and the group cannot be reactivated. See the **Inactivate a Group** section for more information.

3. The list can be sorted by any column or narrowed by using a filter for **Current Status**. Active teams are listed first, followed by inactive teams.

**Note:** the list of groups can be narrowed by using a filter for **Current Status**. Active teams are listed first, followed by inactive teams.

**Figure 204 - Group List Screen**

![Group List Screen](image)

**Search for a Group**

A user can search for a group to view or modify.

1. Select **Search for Group** on the **Groups** drop-down menu on the PCMM Web home page to display the **Search for Group** dialog box.

**Figure 205 - Search for Group Menu Option**

![Search for Group Menu Option](image)

2. Enter all or part of the group name desired in the **Name** field and click **Search** to display a list of groups with that search criteria. Alternatively, a user can also leave the Name field blank and click the **Search** button to display a list of all groups for that station.
3. The *Search for Group* dialog box will display. The following columns are displayed in the group list table:
   - Name
   - Description
   - Select

4. Click an icon (blue check) in the **Select** column for the desired group to display the *Modify an Existing Group* screen. See the Modify an Existing Group section for more information.

   ![Figure 206 - Search for Group Screen](image)

**Modify an Existing Group**

A user can view or modify information for a group in the *Modify an Existing Group* screen.

1. From the *Modify An Existing Group* screen for the group (see the Modify An Existing Group section), the following information will be displayed:
   - Name
   - Station
   - Description
   - Primary Point of Contact Name
   - Primary Point of Contact Phone
   - Primary Point of Contact E-mail
   - Primary Point of Contact City
   - Primary Point of Contact State
   - Current Status (Active or Inactive)
   - Activation Date

2. A user can edit the **Name**, **Description**, and all **Primary Point of Contact** information.
3. A user can also:
   - Click the **View Active Team Assignments** toggle link at the bottom of the screen to view a list of team and room assignments.
   - Make new team assignments to the group by clicking the **View Active Team Assignments** toggle link, and then clicking the **Assign Team** button.
   - Click the **View Inactive/Historical Team Assignments** toggle link at the bottom of the screen to view a list of historical data.

4. Click **Submit** to save any changes and display the **Groups List** screen. A confirmation message will appear at the top of the screen.

Figure 208 - View Active Team Assignments Screen
Assign and Unassign a Team from a Group

A user can assign or unassign a team to or from a group in the *Modify an Existing Group* screen.

**To Assign a Team:**

1. From the *Modify an Existing Group* screen for the group (See the Modify An Existing Group section), click the **View Active Team Assignments** toggle link at the bottom of the screen to view a list of team and room assignments. The following information will display:
   - Aggregate Panel Details (total for the whole group)
   - Aggregate Modeled Capacity
   - Aggregate Maximum Capacity
   - Aggregate Assigned
   - Aggregate Available
   - Team
   - Care Type
   - Focus
   - Station
   - Modeled (Team Capacity)
   - Maximum (number of patients assigned)
   - Assigned (patients assigned to the team)
   - Available (number of patients available to be assigned to the team)
   - Assignment Start Date
   - Actions (Use this column to unlink the team from the group assignment. See the next section for more information.)
   - The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus.

2. Click the **Assign Team** button to display the *Team Assignment* dialog box.

   **Figure 209 - Assigning a Team to a Group**

3. Click the **Search** button to display the *Search for Team* dialog box.
Figure 210 - Team Assignment Box with the Search Button Selected

4. Enter all or part of a team name and click **Search** to display a list of team names. Alternatively, leave the field empty and click **Search** to display a list of all available team names.

Figure 211 - Search for Team Screen to Assign Team to Group

5. Click the name link to populate the **Team** field in the **Team Assignment** dialog box.

Figure 212 - Team Assignment Box with Team Selected

6. Click **Submit** to continue, **Cancel** to cancel. A confirmation message will display at the top of the screen.

**To Unassign a Team:**

1. Click the **View Active Team Assignments** toggle link.
2. Click the red **X** icon in the corresponding **Actions** column.
3. The Are You Sure? dialog box will display. Click **Confirm** to unlink the team from the group, or click **Cancel** to close the dialog box without making changes.

   **Figure 214 - Confirmation to Unlink Team from Group**

4. Click the **View Inactive/Historical Team Assignments** toggle link. The following information will be displayed:
   - Team
   - Care Type
   - Focus
   - Station
   - Assignment Start Date
   - Assignment End Date
   - The list can be sorted by any column.

5. The inactive team assignment will be displayed in the list.

   **Figure 215 - View Inactive/Historical Team Assignment Screen**
Inactivate a Group

A user can inactivate a group in the List Groups screen.

1. From the Groups List screen, click the icon (trash can) in the Actions column. Note that once a group is inactivated, all teams assigned to the group are unassigned from the group and the group cannot be reactivated.

   Figure 216 - Group List Screen to Inactive Group

2. The Are You Sure? dialog box will display. Click Confirm to inactivate the group, or click Cancel to close the dialog box without making changes.

   Figure 217 - Confirmation to Inactive Group from Team

3. The View an Existing Group screen will display, with a confirmation message and the Status listed as Inactive. All values will be defaulted to zero in the View Team Assignments section.

4. Click the View Inactive/Historical Team Assignments toggle link. The following information will be displayed:
   - Team
   - Care Type
   - Focus
   - Station
   - Assignment Start Date
   - Assignment End Date
   - The list can be sorted by any column.
REPORTS

Background Job Log

A user can search and view background job logs from this screen.

1. From the main menu, click **Reports > Background Job Log**. The job list will display all records associated with the station the user is logged into when signed in to PCMM Web.

   ![Figure 218 - Background Job Log Menu Option Selected](image)

2. Use the selection criteria to choose another query. Select:
   - **Job Type**, if desired *(Any is the default, but a user can filter by CPRS Header Sync, CPRS Header Sync Monitor, Patient Auto-Inactivation, Patient Bulk Transfer, Staff Update or VistA Sync )
   - **Job Started After** *(Current day and time is the default)*
   - **Job Started Before**, if desired
   - **Include jobs not associated to any station** and **Include jobs linked to a specific station** are checked by default. Uncheck if desired
   - **Station**.

   ![Figure 219 - Background Job Log Screen](image)

3. Click **Submit** to continue, **Cancel** to cancel.

4. The system will display a table with the following columns:
   - **Station**
   - **Type**
   - **Start Time**
   - **End Time**
   - **Initiator**
   - **Details**
   - Filter the results by **Station**, **Type** and **Initiator**.
5. To see the details of a job, click the View Job Results Details icon in the Details column that corresponds to the job to view.

6. The Result of Batch Job Execution screen will display with the following columns:
   - Patient
   - Position
   - Team Status
   - Result Details
   - Completion Time

   Depending on the type of job selected, the appropriate details will display in the table.
   - The CPRS Header Sync job type will display the Patient name that links to Patient Profile screen.
   - The Patient Bulk Transfer job type will display the requestor's name and email link. Uncheck the Include jobs linked to a specific station check box and select a station before proceeding.
Canned and Ad Hoc Reporting

Active Panel Report

This report depicts the Capacity and FTE for each team and optionally each staffed team roles on each team. Note: PCMM Web uses SQL Server Reporting Services to run PCMM Web reports. This enables reports to return results faster than having PCMM Web run reports through its own web application.

With the appropriate permissions, a user can run reports. If not, they will be read-only.


2. Click the appropriate folder view the PCMM Web reports. The following reports are:

Active Panel Report

3. Select from the following SSRS parameters:
   - **Date** (required): Default to current date/time, or enter in text box or choose from calendar control). If applicable, the information for the report will display everything on record through the specified date and time.
• **Report level:** (required): Default to station, but can choose from National, VISN, or station. For stations, a user can choose Position Detail.

• **Care Type** (required): Default is All

• **Focus**

4. The following fields will be displayed:

- **Station**
- **Team**
  - Care Type/Focus
  - Name
    - **Position(s)** (Note: Only display this field when “Include Position Detail” check box is selected)
  - Team Status (Indicator for Team)
- **Capacity**
  - Allowed (Total Number of Patients Allowed for each active team role on the team)
  - Assigned (Total Number of Patients with current active assignment to the team)
  - Available (Patient allowed minus patient assigned)
  - Utilization (Patient assigned divided by patient allowed times 100 = percentage)
- **FTE**
  - Expected (Total expected FTE for each active team role on the team)
  - Actual (Total actual FTE captured for each active staff assignment to each active team role on a team)
  - Utilization (Actual FTE divided by expected FTE divided by 100 = percentage)

• **Potentially Deceased**

**Include Position Detail**

- If the **Include Position Detail** box is checked, all active team roles with active staff assignments will be displayed.
- This option provides the capacity and FTE for all the active positions with the active staff assignments for each team included in the report and will be listed under the Team Name. (Ex. Staff Name - Position Assignment)
- The data for the assigned capacity and FTE associated with each team role can be retrieved from the following screens:
  - Position Profile (Allowed Patients, Assigned Patients, Available Patients, Expected FTE)
  - Show Staff (Actual FTE)

- The **Position Detail** will be listed in the following order:
  - PCP, if applicable (If there is an active preceptor on team; search for Preceptor but display as PCP)
  - AP(s), if applicable (If there are any active preceptees for team; search for Preceptee but display as AP)
  - If Preceptor/Preceptees are listed; then a Subtotal row will be provided for the assignments of PCP/AP for capacity and FTE.
  - Care Manager
  - Clinical Associate (Clinical Assc)
  - Administrative Associate (Admin Assc)
  - Any additional active team roles with staff assignments will be listed.
Pending Patient Assignment Report

This report determines how long PACT assignments took to activate. This report displays all patient assignments to teams with a care type of “Primary Care” that have a “Pending” status. The items reported include:

- Pending Assignments to Primary Care Teams.
- Canceled Assignments to Primary Care Teams.
- 
  1. Select from the following SSRS parameters:

Report Type: Detail
Target Audience: VISN and Principal Facility PCMM Coordinators
Update Frequency: This report extracts data from PCMM Web and is generated in real time.
Parameters to be included: Number of pending, active and cancelled patients by National, VISN, facility, and divisions.
VISN: All VISNs the user is authorized to view are displayed. User selects the VISN(s) to include on the report.
Station: All Stations for the selected VISN(s) are displayed. User selects the Station(s) to include on the report.
Division: All Divisions for the selected Station(s) are displayed. User selects the Division(s) to include on the report.
Focus: All Focuses are displayed. User selected Focus(s) to include on the report.

Current Assignment Status: User selects Canceled or Pending or Both.

Data Columns:
- VISN #
- Station #
- Focus
- Current Assignment Status

# Days Pending: The number of days the patient’s PACT team assignment has a PENDING status since assigned to the PACT team.
MPACT: The overall status of a MPACT Request will display in the report if a MPACT Request is associated with a PACT team assignment for a patient.
Team Name: The name of the assigned PACT team.
PCP Name: The name of the primary care provider the patient is assigned to on the PACT team.
Assignment Start Date: The date and time the patient was originally assigned to the PACT team.
Assignment End Date: The date and time the patient was unassigned from the PACT team.
Unassign Reason: The reason for unassignment.
Patient Name – Includes the last name, first name, and middle name of the patient. This may be restricted to some users.
Patient SSN – Includes the Social Security Number of the patient. This may be restricted to some users.
ALERTS AND NOTIFICATIONS

Alerts and notifications are used for efficiently communicate tasks and information to users with in the PCMM Web application. **Notifications** are system generated messages that is assigned to a team or a user when a death, transfer, inactivation, or a team change occurs and no further action is required. **Alerts** are system generated message assigned to a user to take action with in PCMM Web, or outside of the application. These alerts are sent to the PCMM Coordinator and/or PCMM TVC.

Manage Team and Team Role (Position) Notifications

PCMM Web will generate VistA mailman messages to team members when certain assignment/unassignment activity occurs. If needed, a user has the ability to select which notification(s) are received by which team member(s) on both the Team Profile and Team Position Profile screens.

1. Once the **View/Edit the Notification Distribution Rules** link is expanded, select PCMM or CPRS from the Filter drop-down list to filter the list by Originator settings.
2. Select the **Do Not Send** check boxes next to the notifications that are not sent to the team (all notification types selected by default). Notification Types are:
   - Death
   - Inpatient Admit/Transfer/Discharge
   - Automatic Inactivation
   - Team

   **Figure 224 - Notifications List Screen**

3. Click **Submit** to save any changes. A message will appear at the top of the screen to indicate team changes were saved successfully.
   - If a notification is deselected, select either:
     - **All Team Patients** (to send notifications regarding all team patients), or
     - **Only Patients assigned to this Position** (to send notifications regarding just patients assigned to the team role).

**Note:** Users may use the filters above and below the table to restrict or expand the number of rules shown.
Manage Alerts

There are two types of alerts:
- **Actionable** - requires action on behalf of a user.
- **Informational** - for information purposes only.

**Actionable Alerts:**

**Staff:**
- PCMM Coordinator receives an alert when a Staff Member has a Termination Date.
- PCMM Coordinator receives an alert when the person class for the staff has changed and is no longer valid for the team role.

**Auto-Inactivation:**
- PCMM Coordinator receives an alert when Patient Scheduled for Inactivation.

**MVI ICN:**
- PCMM Coordinator receives an alert when a patient was moved via MVI ICN mismatch process (Surviving/Deprecated).
- PCMM Coordinator receives an alert when the patient and all his assignments were merged due to duplication. (Surviving/Deprecated).

**Multi PACT Request:**
- Local TVC receives an alert for approval/reason entry of a pending PACT assignment at local station.
- All TVC(s) at the station(s) listed in the “Required PACT Approvers” section receives an alert requiring approval/denial.
- Only TVC(s) at stations that have not responded to the request receives the resent alert.
- Alert is sent to all PCMM Coordinator(s) on the request to unassign a patient from the station(s) PACT team when a Permanent Relocation has been completed and a request has been withdrawn.

**Informational Alerts:**

**Team Configuration:**
- PCMM Coordinator receives an alert when one or more team roles were created/updated by applying a model team template.
- PCMM Coordinator receives an alert when a model that may apply to this team has been updated.

**Batch Job Execution:**
- PCMM Coordinator and the user receive an alert when a batch process to historical assign, unassign, or transfer patients between team roles was completed.

**Auto-Inactivation:**
- PCMM Coordinator receives an alert when:
  - Patient Automatically Inactivated due to Death Entry
  - Patient Automatically Inactivated due to Inactivity
  - Patient Automatically Reactivated due to Death Entry Revocation

**Panel Placement Request:**
• PCMM Coordinator at site generating the request and the PCMM Coordinator at the site listed on the request receives alert when a Panel Placement Request was created or updated.

Multi PACT Request:
• PCMM Coordinator at a local station receives an alert after confirming a Multi PACT request creation upon assigning a patient to a local PACT team while the patient has an Active PACT assignment at another station.
• All TVC(s) receives an alert stating this station has approved the Multi PACT request with the exception of the station that just approved.
• All TVC(s) and PCMM Coordinator(s) at all stations listed in the “Required PACT Approvers” receive an alert for the overall status of the request. (Approved/Denied/Withdrawn).
• All TVC(s) and PCMM Coordinator(s) at all stations receive the denial alert with the exception of the station that just denied it.
• All TCVs and PCMM Coordinators on the request receive an alert when request is Withdrawn or Auto Canceled due to identity issues.
• Escalation alert is sent to the station TVC who has not taken action on the request within 15 days.
• Escalation alert is sent to the VISN TVC when the station TVC has not taken action on the request within 30 days.
• Escalation alert is sent to the National PCMM Coordinator if no action is taken on the Multi PACT request within 45 days.
• Alert is sent to all TVC(s) on the request stating Permanent Relocation has been completed and request is withdrawn.

View Alerts Summary for a Station

The Alerts Summary displays a summary of all available alerts from all authorized stations that the user is assigned. Only stations that have alerts available for viewing will be displayed.

1. From the PCMM Web Home Page, click the Alerts menu and select Alerts Summary to display the Alerts Summary screen.

   Figure 225 - Alerts Summary Menu Option Selected

2. If any alerts are pending, a notice box in the top right side of the PCMM Web home page will display. Click the link to display the Alerts Summary screen.

3. The Alerts Summary screen provides the following alert information:
   • The station name and number.
   • The number of alerts for each station listed.
A user can use the **First, Previous, Next,** and **Last** buttons to navigate the list of alerts. Display the number of rows shown by selecting a number from the **Display Records** drop-down menu.

**Figure 226 - Alert Summary Screen**

![Alert Summary Screen](image)

4. To view the alert details for each message, click the icon in the **View** column. The **Open Alerts List** screen will display.

**Note:** If selecting a different station, the system will automatically change the station for the user and allow them to view the alerts. The user will receive a message stating that the station has been changed once a station has been selected.

5. The **Open Alerts Lists** screen will display all of the Actionable and Informational alerts available for the user.

6. For each alert with an Alert Type of **Informational**:
   - One alert will be sent to each user who holds the security role defined as an **Alert Recipient**. Each user will be responsible for managing their own Informational alerts. If the specific alert does not exist for the user; it will be created. If the specific alert already exists for the user; another alert will not be created (i.e. the user will not see two of the exact same alerts).

7. For each alert with an Alert Type of **Actionable**:
   - One alert will be sent to each user who holds the security role defined as an **Alert Recipient**. The actionable alert will then be closed and removed from each user’s alert list who received the alert.

**Figure 227 - Open Alerts List Screen**

![Open Alerts List Screen](image)

### Open Alerts List for a Current Station

A user can view and update all open alerts for a station.

1. From the PCMM Web Home Screen, click the **Alerts** menu and select **Open Alerts List for Current Station** to display the **Open Alerts List** screen.
2. A user can perform the following functions on the Open Alerts List screen:

- Click the View Alert Summary link to view the summary of alerts all assigned station.
- Click the View Closed Alerts link to view all closed alerts for the station.
- Click the + symbol in the header to show all comments for all alerts in the list.
- Click the + symbol next to an alert to view comments only for that alert.
- To delete an alert, select the check box next to the alert or select the All check box to delete all alerts on the screen. Click the Delete button.
- Sort by Actionable and Informational alerts by using the filter drop-down list above the Type column.
- Sort by system using the filter drop-down list above the Sender column.
- Sort all other columns using the arrow icons. The default listing order is by Requires Action type and by date and time.
- Use the First, Previous, Next, and Last buttons to navigate the list of alerts.
- Change the number of rows shown by selecting a new number from the Display Records drop-down list.

Updating an Alert:

1. Click the View/Action on Alerts icon in the Actions column to display the appropriate screen that the alert was generated from.
2. A message displays at the top of the screen with two links. Click the Save for Later link to save the alert in the Open Alerts List Alert screen. Click the Mark as Complete link to mark the alert as complete and move the alert to the Closed Alerts List.

   Note: The message will remain visible on the screen until the user completes one of the actions. If the user navigates away from screen, the same message will display on the next screen until action is taken.

Adding Comments to an Alert:

3. Click the Update Comments icon in the Actions column to display the Enter a Comment dialog box.
4. Enter the necessary information and click Submit to save a comment or Cancel to return to the Open Alerts List screen without saving the comment.
5. The Comment is now attached to the alert and can be viewed when the user clicks the expand plus sign on the left of the alert.

Deleting an Alert

6. Click the Delete Alert icon in the Actions column to display a dialog box to either confirm or cancel the deletion.
View Closed Alerts List for a Current Station

A user can view all the closed alerts and alerts marked as complete for the station. The alert is never deleted and a historical record is kept in the system. The Alert table displays the user that closed the alert and the date and time of that action. No further action can be made to closed alerts.

1. From the PCMM Web Home Screen, click the Alerts menu and select Closed Alerts List for Current Station to display the Closed Alerts List screen.

2. A user can perform the following functions on the Closed Alerts List screen:

   7. Click the View Alert Summary link to view the summary of alerts all assigned station.
   8. Click the View Open Alerts link to view open alerts a station.
   9. Click the + symbol in the header to show all comments for all alerts in the list.
   10. Click the + symbol next to an alert to view any comments only for that alert.
   11. Sort by Actionable and Informational alerts by using the filter drop-down list above the Type column.
   12. Sort by system using the filter drop-down list above the Sender column.
   13. Sort all other columns using the arrow icons.
   14. Change the number of rows shown by selecting a number from the Display Records drop-down menu.
   15. Send an email to the user who closed the alert by clicking the envelope icon next to their title.
Result of Batch Job Execution

Once a batch process is submitted, a user will be notified that the batch job is complete. A user can then view the alert and additional details in the Batch Execution Results screen.

1. From the Alerts drop-down menu, select Open Alerts List for Current Station to display the Open Alerts List screen. Alternatively, any alerts pending display in the notice box in the top right side of the PCMM Web home page. This notice provides a link to the Alerts Summary screen.

   ![Figure 231 - Open Alerts List for Current Station Menu Option](image1)

2. Select the View/Action on Alerts icon in the Actions column to display the Result of Batch Job Execution screen.

   ![Figure 232 - Selecting Actions Icon to View Results of Batch Job Execution](image2)

3. View the list of batch results for each patient. A user can filter the list using the controls next to each heading.
ADMINISTRATION

Performing Administrative Tasks

Administrators have the ability to manage various tasks. They can do the following:

- Manage the permissions settings that drive the activities a particular provider can perform.
- Assign administrative and functional stations to a system user within their own station.
- Manage the users under their own area or those of areas under their responsibility.

Local Administrators can assign stations to a system user within their own station. Each PCMM Web user must have VistA privileges for each specific division they need to access per 5 digit station level. Access to a main facility (i.e., 3 digit station level) will only provide access to the main facility data.

Regional and National Administrators have a larger pool of stations available to them for assignment of users. This is helpful when a system user is an Occupational Health (OH) provider at multiple facilities.

Manage and Modify Reference Data

A PCMM Web National Administrator is able to view and manage the data on the drop-down lists within the PCMM Web application, so that the selection list of values will not require modification by developers and will available immediately.

To Manage Reference Data:

1. From the Administration drop-down menu, select Manage Reference Data to display the Manage Reference Data screen.
2. Select a reference type from the Reference drop-down list and click View to display a list of data.
3. Click a name link in the Name column to display the Modify Reference Data screen. The Modify Reference Data screen will display the Care Type and Focus data, while the Manage Reference Data screen will display for the Non-VA Provider Role choice.
4. Enter/change the following information:
   - Name
   - Description
   - Sort Order
   - Justification
   - Check the box to inactivate the data record, if desired. An Inactivate Reason will be required to save the record. If the record is an existing record, the Code cannot be changed
5. Click Submit/Confirm to save, Cancel/Confirm to exit without saving changes and return to the Manage Reference Data screen.
6. A user also has the option of selecting another reference type to display. Select another choice from the Reference: Type drop-down list and click View.
To add a New Value:
1. Add a new value by clicking the Add New Value button. The Add Reference Data screen will show. Enter:
   - Code (required)
   - Name (required)
   - Description (required)
   - Sort Order
   - Justification
   - Inactivate (this can be used to initially inactivate, enter the data and activate at a later date)
   - If Inactivate is chosen, an Inactivate Reason text box will display. Enter a reason.
2. Click to Submit and save changes, or Cancel to cancel.

Help File

A user can view the PCMM Web Help from the Help Menu for step-by-step procedures on how to assign a team, assign a patient to a profile, update a team role, and more. Additionally, helpful hints and information about the application is available in the help file.

To view the PCMM Web help file:

1. Select Help > Web Help from the main menu to display the PCMM Web Help File.

   Figure 233 - Web Help Icon Selected

   ![Web Help Icon Selected](image)

   Note: The PCMM help file is also launched by click the icon and is available on the upper left side of the screen, below the Main Menu and bread crumb links.

   Figure 234 - Help Icon in PCMM Web

   ![Help Icon in PCMM Web](image)

   2. A user can view the following information by clicking on the Table of Contents icon.
3. In the PCMM Web Help File, users can search for a specific topic or subject by selecting the Index, Search, and Glossary tabs.
   - **Index** – Lists keywords alphabetical. Click the **keyword** to display a pop-up menu of topics related to the selected keyword. Select the topic to view additional information.

   ![Figure 236 - Index in PCMM Web Help File](image)

   - **Search** – Enables a user to search for a topic by entering the keyword. All topics with the keyword display, according to rank.
   - **Glossary** – Lists glossary terms alphabetical.
Reference Menu

The Reference Menu provides a user with easy access to important links, policies and procedures, and other publications directly from PCMM Web.

Primary Care Links

1. Select Reference > PACT SharePoint from the main menu to display the PACT SharePoint site.
   - The SharePoint site provides helpful resources to implement the Patient Aligned Care Team (PACT) at your local facility.

2. Select Reference > PCMM Training from the main menu to display the Primary Care Management Module (PCMM) Training Home page.
   - The PCMM Training page provides links to training material and information related to PCMM.

3. Select Reference > VSSC PCMM Coordinator List from the main menu to display the National PCMM Coordinator & Referral Case Manager List.
   - The National PCMM Coordinator & Referral Case Manager List provides a list of PCMM VA facilities and coordinators.

   Figure 237 - Primary Care Links Menu Options

Mental Health Links

4. Select Reference > Mental Health Links from the main menu to display the Mental Health Services Training Resources SharePoint site.
   - The SharePoint site provides helpful resources to implement the related Mental Health PCMM.

5. Select Reference > BHIP Team Basics from the main menu to display the Behavioral Health Interdisciplinary Program Teams page.
   - The BHIP page provides tools to help build Collaborative Teams, Veteran Centered Care, and Care Coordination and Access related to mental health care for Veterans.

6. Select Reference > Mental Health Dashboard from the main menu to display the Mental Health Dashboard report page.
   - The Mental Health Dashboard includes a report summary and stats for several VA facilities.

![Figure 238 - Mental Health Links Menu Options](image)

**Troubleshooting**

If screen display issues occur when working in PCMM Web, enable Compatibility Mode in the browser. This issue may occur in Internet Explorer browsers. To manually enable the setting, open PCMM in Internet Explorer and click the **Tools** button and then click **Compatibility View** settings. Under Add this website, enter the PCMM Web URL site to add to the list and click **Add**.

**User Roles**

The following are the available roles to assign a user in PCMM Web.

**Table 3 – User Roles, Descriptions, and Permissions**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>PCMM Web Assigned Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCMM Coordinator</td>
<td>Able to utilize all functionality to create, manage and assign to any PCMM team.</td>
<td>PCMM COORDINATOR</td>
</tr>
<tr>
<td>PCMM MH Coordinator</td>
<td>Able to utilize all functionality to create, manage and assign to MHTC PCMM teams only.</td>
<td>PCMM MH Coordinator</td>
</tr>
<tr>
<td>PCMM MultiPCP Clinical Approver</td>
<td>Clinicians currently and potentially caring for the patient or their clinical designee responsible for determining whether there is compelling clinical need for Multi-PACT assignments.</td>
<td>PCMM COORDINATOR</td>
</tr>
<tr>
<td>PCMM Specialty Coordinator</td>
<td>Responsible for Non-PACT PCMM management, setup</td>
<td>PCMM Specialty Coordinator</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>PACT Administrator – Limited View</td>
<td>Able to view all areas within the application except for patient level data.</td>
<td></td>
</tr>
<tr>
<td>PACT Administrator – View All</td>
<td>Able to view all areas within the application including patient level data.</td>
<td></td>
</tr>
<tr>
<td>PCMM Clerk</td>
<td>The role assigned for staff members who performs data entry tasks.</td>
<td></td>
</tr>
<tr>
<td>PCMM MH Clerk</td>
<td>The role assigned for staff members who performs data entry tasks for MH teams only.</td>
<td></td>
</tr>
<tr>
<td>PCMM Reports Only</td>
<td>User access to PCMM reports only.</td>
<td></td>
</tr>
<tr>
<td>PCMM Specialty Clerk</td>
<td>The role assigned for staff members who performs data entry tasks for Non PACT areas only.</td>
<td></td>
</tr>
<tr>
<td>PCMM Traveling Veteran Coordinator</td>
<td>Facilitates PCMM Multi-PACT requests while acting as the liaison between sending/receiving facilities for traveling veterans needing care coordination and communicates with the TVC at the other facility to obtain/send information.</td>
<td></td>
</tr>
<tr>
<td>PCMM Back-up Traveling Veteran Coordinator</td>
<td>Serves as the back-up to the TVC</td>
<td></td>
</tr>
<tr>
<td>PCMM VISION Coordinator</td>
<td>This designated staff member serves as the VISN’s PCMM technical expert with the ability to utilize and troubleshoot all areas of the application and has the ability to access and delegate PCMM user permissions and necessary user training.</td>
<td></td>
</tr>
<tr>
<td>PCMM VISION Traveling Veteran Coordinator</td>
<td>Serves as the VISN TVC SME with the ability to act on the VISN’s facilities PCMM Multi-PACT requests as needed.</td>
<td></td>
</tr>
<tr>
<td>PCMM Back-up Principal Facility Coordinator</td>
<td>Serves as the back up to the Principal Facility</td>
<td></td>
</tr>
</tbody>
</table>
There is one PCMM Principal Facility Coordinator for each VistA location (parent station and divisions). This designated staff member serves as the facility’s PCMM technical expert with the ability to utilize and troubleshoot all areas of the application and has the ability to access and delegate PCMM user permissions and necessary user training.

### Table 4 - Detailed Role Table

<table>
<thead>
<tr>
<th>ROLE</th>
<th>PCMM National Coord.</th>
<th>PCMM VISN Coord.</th>
<th>PCMM Principal Facility Coord.</th>
<th>PCMM Coord.</th>
<th>PCMM VISN Traveling Veteran Coord.</th>
<th>PCMM Traveling Veteran Coord.</th>
<th>PCMM MH National Coord.</th>
<th>PCMM MH Coord.</th>
<th>PCMM MH Clerk</th>
<th>PCMM Specialty Coord.</th>
<th>PCMM Specialty Clerk</th>
<th>PCMM Non-VA Care Coord.</th>
<th>PACT Administrator – View All</th>
<th>PACT Administrator – Limited View</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Patient Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Patient to PC</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Patient to MH</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Patient to Spec</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Patient to NVA Care</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Patient</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Team Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create PC Teams</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update PC Teams</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete PC Teams</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create MH Teams</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update MH Teams</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete MH Teams</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Spec Teams</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Update Spec Teams</td>
<td>Delete Spec Teams</td>
<td>Create NVA Care Teams</td>
<td>Update NVA Care Teams</td>
<td>Delete NVA Care Teams</td>
<td>View Teams</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>-----------------------</td>
<td>-----------------------</td>
<td>-----------------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Room Management</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Rooms</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Rooms</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Rooms</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Rooms</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Management</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Groups</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Groups</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Groups</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Groups</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model Configuration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Models</td>
<td>x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Models</td>
<td>x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Models</td>
<td>x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Models</td>
<td>x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-VA Provider</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create NVA Provider</td>
<td>x x x x x</td>
<td>x x x x x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update NVA Provider</td>
<td>x x x x x</td>
<td>x x x x x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign NVA Provider</td>
<td>x x x x x</td>
<td>x x x x x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View NVA Provider</td>
<td>x x x x x</td>
<td>x x x x x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage Reference</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Reference Data</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Reference Data</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Reference Data</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Reference Data</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>x x x x x</td>
<td>x x x x x x x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>x x x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 5 - Detailed Care Type Table

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Care Type per Role</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Care</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Care - HBPC</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case Management</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Community Care</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inpatient SCI</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mental Health</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-PC Specialty (Med/Surg)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-VA Care</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transition and Care Management</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
508 Compliance

Contact the VA Project Manager, Aaron Lindstrom, to request the PCMM Web User Guide document in alternative formats, if needed.

Aaron.Lindstrom@va.gov
GLOSSARY

ACOS: Associate Chief of Staff.

Admin Coordinator: The administrative coordinator for Primary Care and Non-Primary Care Teams. This person is involved with administrative (MAS requirements and/or Clinic Administration) duties as well as oversight of the Scheduling process and Primary Care team definition.

Alerts: Alerts are system-generated messages that provide information. Alerts are either Informational or Actionable. A user must have the appropriate security access to view alerts.

Arrow: Arrow is a symbol that is used to scroll up and down lists, and left to right for moving objects (patient names, e.g.).

Associate Provider: An Associate Provider is authorized to provide primary care, but cannot act as a Primary Care Provider. In PCMM, a Resident is designated as an Associate Provider. A Nurse Practitioner and/or Physician Assistant may be designated as an Associate Provider also. Per VHA Directive every patient is to be assigned to a Primary Care Provider, who is responsible for coordinating a patient’s overall care. Thus, the Associate Provider on a Primary Care Team must be assigned to a preceptor who can be a Primary Care Provider (must have a Primary Care Provider preceptor assigned to them).

Austin Automation Center: The central repository for National Care Patient Care Database.

Auto Team Enrollment/Discharge: This is an option when setting up Teams that will automatically enroll a patient to a TEAM when the patient is enrolled in a clinic that is associated with that team. A user can also discharge from a TEAM (if not assigned to a team role in a team) when the patient is discharged from a clinic associated with that team.

Button Bar: A Button Bar is also referred to as a Tool Bar - small boxes that contain graphic figures that represent various functions.

Calendar Display: Within PCMM, when there is a date field, the user can “double click” the field and a miniature calendar will ‘pop up’ for selection of a date and year. This is used for Activation and Deactivation dates as well as Discharge dates.

Care Type: A required field that describes the type of service being delivered by the teamlet. The user must select an item from the list displayed.

Clerk: This person is a clerk who performs data entry.

Context Bar: The dark blue banner at the bottom of the Banner that shows the user’s duty station, user name, and log out link. There are also buttons of the applications that the user has permissions to use. If the user is an administrator, they can sign on
with no duty station specified (as in the example above) until they begin to perform the functions they have authorization to do.

**Clinical Pharmacist:** Performs patient care duties related to patient medications as assigned or granted by the appropriate governing committee at the facility. These privileges may include and may or may not be limited to:

1. Initiation of renewal orders for chronic maintenance medications
2. Initiation of orders for laboratory tests necessary to monitor existing drug therapy.

**Clinical Service:** A Service defined at the medical center, e.g. Medicine, Surgery, Intermediate Medicine, etc.

**Closing:** Another term for ‘inactivating’ a team role or team.

**Consults:** When a patient is referred to a clinic on a one-time basis, he/she is not normally enrolled in that clinic.

**Control Key:** A Control Key is the key on the lower left and right hand side of the keyboard that is entitled ‘CTRL’. When a user presses this key along with another character (e.g. CTRL + O), the user can select and OPTION, etc.

**Database:** This refers to the information that is stored in your medical center’s computer program, e.g., patient information, service information, clinic information, etc.

**Dialogue Box:** A dialogue box is a box or window that is placed within a screen that allows the user to enter a ‘free text’ message or description of the object being created (in some cases, the description of what a team is supposed to represent).

**Dietitian:** Performs patient care duties related to nutrition and weight management.

**Display Box:** This is a window that displays information or lists available clinics, team roles, or teams to choose from. The user may select an item from the list displayed.

**Double Arrow:** Double arrows are two arrows next to each other indicating that more than one patient name may be moved over from an inactive status to an active status and back to an inactive status. (>>)

**Drop-Down List:** When a user selects an item from the menu bar, a list is displayed in a vertical format. For example, if a user selects **File**, a list drops down showing all options that are available under the main heading **File**: **File, Edit, Print, Save.**

**Duty Station:** A duty station is a location where a person is based (typically, it is where a person receives a paycheck). It may be a place where health care is not provided, such as a national cemetery or an office building.

**E**

**E-Mail Messages:** These are the messages that are generated by a software event that delivers information to designated users via MailMan. E-mail messages in the PCMM module would include information about death notifications, inpatient movements, consult notifications, and team notifications or changes.
F

Footer: The Footer is displayed at the bottom of every window. It displays the version of the application, the copyright date, and a link to contact the application owners.

Functional Station: A location where health care is provided (a treating facility), such as a VA Hospital/Medical Center or clinic.

Focus: The focus further identifies the type of service being delivered by the teamlet. Focus 1 is required for the Care Type of Primary Care and should reflect the principal service delivered. Focus 2 is optional and may serve to further define additional services delivered by the teamlet. The selection of a Focus under the Care Type of Primary Care will auto populate teamlet positions.

H

Highlight: To ‘Highlight’ a name, team, team role, or date, one would place the cursor (or arrow) on the name, team, or team role they wish to choose and ‘click’ the mouse button to select it or highlight it.

History File: Although not specific to any one document, a history file is a compilation of various pieces of information pertaining to individual teams, team roles, etc. for future reference and clarification.

I

Icon: An Icon is an image or snapshot of something that is visually understood and is represented in a ‘box’. For instance, an ICON that stands for ‘cutting’ a piece of text out of a document would be a box with a picture of a pair of scissors in it. They are also known as ‘buttons’.

Intern (Physician): Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner. Duties include, but may not be limited to, (1) completing history & physical examinations, (2) obtaining blood and other specimens, and (3) provision of patient medical care as permitted. The person cannot act as Primary Care Provider. The Intern is an Associate Provider within a Primary Care Team (see Associate Provider Term).

IRM: Information Resource Management

M

MAS ADPAC: Medical Administration Service Automated Data Processing Applications Coordinator

Medical Student: Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner.

Menu: The list of items on the left side of the window. The Menu displays the actions that are available to a user, based on the role.
NPCD: National Patient Care Database - is maintained in Austin and receives selected demographic and encounter-based clinical, diagnostic data from VA medical centers. This data enables a detailed analysis of VHA inpatient and outpatient health care activity.

Nurse (LPN): Provides a variety of nursing services that do not require full professional nurse education, but are represented by the licensing of practical and vocational nurses by a State, Territory or the District of Columbia. Persons in these team roles may also provide administrative assistance, such as making appointments, etc.

Nurse (RN): Provides care to patients in clinics and other settings, administers anesthetic agents and supportive treatments to patients undergoing outpatient surgery and other medical treatments, promotes better health practices, and consults or advises nurses providing direct care to patients. Persons in this team role require a professional knowledge and education in the field of nursing.

Nurse Practitioner: Performs patient care duties in accordance with Scope of Practice under the supervision of a designated physician or physicians and Medical Center Policy. Duties include, but are not limited to, appropriate assessments, orders diagnostic tests and consultations as necessary, prescribes treatment interventions in accordance with established protocols, provides or arranges follow-up care, and provides health teaching and supportive counseling. Is authorized to act as a Primary Care Provider or Associate Provider. The ability to act as a Primary Care Provider is decided by individual facilities.


Other: A general classification for those team members who do not belong in any of the listed Standard Position entries.

Panel: A panel is a group of individual patients for which the Primary Care Provider has accepted primary care responsibility.

Patient Panel: Group of individual patients assigned to a Team/Position.

Practitioner: Can be either Primary Care or Non Primary Care patients; e.g., the Practitioner’s Patients Report includes both Primary Care and Non Primary Care patients assigned to the practitioner in the Patient Panel Count.

Patient Services Assistant: Provides clerical and patient processing support to outpatient clinics, or other unit of a medical facility, in support of the care and treatment given to patients. This includes duties as receptionist, record-keeping duties, clerical duties related to patient care, and miscellaneous support to the medical staff of the unit.

PC Coordinator: Primary Care Coordinator

PCMM: Patient-Centered Management Module

Person Class File: Consists of provider taxonomy developed by Health Care Finance Administration (HCFA). The taxonomy codifies provider type and provider area of specialization for all medical related providers.
**Physician Assistant:** Performs patient care duties in accordance with Scope of Practice under the supervision of a designated physician or physicians and Medical Center Policy. Duties include, but are not limited to, diagnostic and therapeutic medical care and services, taking case histories, conducting physical examinations, and ordering lab and other studies. Physician Assistants also may carry out special procedures, such as giving injections or other medication, apply or change dressings, or suturing minor lacerations. The ability to act as a Primary Care Practitioner is decided by individual facilities.

**Physician-Primary Care:** As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. As a Primary Care practitioner, the incumbent provides the first point of assistance for a patient seeking care. Primary Care duties include: (1) Intake and initial needs assessment, (2) Health promotion and disease prevention, (3) Management of acute and chronic biopsychosocial conditions, (4) Access to other components of health care, (5) Continuity, and (6) Patient and non-professional care giver education & training. (from IL 10-93-031, Under Secretary for Health’s Letter) Can act as Primary Care Practitioner.

**Physician-Psychiatrist:** As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. The incumbent is also granted clinical privileges (by the appropriate governing Credentials committee) in regard to the practice of Psychiatry.

**Physician-Subspecialty:** As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. The incumbent is also granted clinical privileges (by the appropriate governing Credentials committee) concerning the practice of Specialty or Subspecialty care in the areas of Medicine or Surgery.

**Position:** Or referenced as Team Roles. Teams are comprised of one or more staff positions (or team roles). Individual practitioners are assigned to a team position (or role). A position (or role) is designated to serve certain roles in the overall primary care setting.

**Preceptor:** Responsible for providing the overall care for patients assigned to an Associate Provider or Medical Student. On Primary Care Teams, the Preceptor must be able to provide Primary Care.

**Primary Care:** Primary care is the provision of integrated, accessible health care services by clinicians that are accountable for addressing a large majority of personal health care needs.

**Patient-Centered Management Module (PCMM):** Patient-Centered Management Module is the application for VA facilities to use for implementing primary care teams. Teams are created, team roles associated with the teams are created, staff members are assigned to team roles, and patients are assigned to the teams and team roles.

**Primary Care Provider:** In PCMM, the Primary Care Provider is the team role determined to be responsible for the coordination of the patient’s primary care.
**Psychologist:** Performs patient care duties in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Psychology and Mental Health. This may include individual, family and group counseling and psychotherapy, assertiveness and other behavior training, etc.

**Rehab/Psych Technician:** Provides patient care in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Psychology and Mental Health. This may include individual, family or group counseling. A degreed Psychologist or Mental health practitioner typically supervises the incumbent.

**Remedy Ticket:** A support request that is sent to the VA Service Desk.

**Resident (Physician):** Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner. Duties include, but may not be limited to, completing history and physical examinations, obtaining blood and other specimens, and provision of patient medical care as permitted. The resident is an Associate Provider within a Primary Care Team. As a Resident, the incumbent is responsible for providing patient care as directed by the Preceptor. Cannot act as Primary Care Provider.

**Role:** A function or task of a staff member involved with the implementation, maintenance and continued success of primary care.

**Section 508 Compliance:** Applications that are Section 508 compliant can be used with assistive technology software.

**Social Worker:** Performs patient care duties in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Social Work. Provides direct services to individuals, groups and families with counseling, discharge planning, crisis intervention, etc.

**Specialty Clinics:** A set of clinics that are defined as SUBSETS of generalized Service clinics such as Cardiology (specialty of Medicine); Orthopedics (specialty of Surgery), etc.

**Team:** Teams are groups of staff members organized for a certain purpose (e.g., Primary Care).

**Team Capacity Override:** This option is available when the user selects to override the capacity and represents the adjusted number of patients that should be assigned to this team. This functionality is only used with Primary Care types that have a Focus of Primary Care Only or Women’s Health. This field. This adjusted value must be > 0 and can be < or > the Team Modeled Capacity.

**Team Modeled Capacity:** The total number of patients that should be assigned to this team (e.g. the Panel Size for the team). This value is taken from the Aggregated Modeled Team Capacity for station and adjusted according to the team’s Primary Care Direct Care, Support Staff FTE, and Room Utilization.
Team Pharmacist: A pharmacist who: (1) Is authorized to Fill/Dispense medications (2) Enter/Verify medication orders (3) Provide patient education relating to medications (4) Renew established medications under the protocols defined by the medical center.

Team Profile: This is a screen within PCMM that shows the various characteristics of a particular team, e.g., number of patients allowed for enrollment, name, team roles assigned, etc.

Text Box: The text box is also known as the DIALOGUE box as described above. It provides the user with an area in which to identify certain characteristics of a particular component of PCMM. For example, the description of what a team is for (provides primary care to patients that have been discharged from the hospital within the last 6 months).

Title Bar: Title bar is the bar that shows the TITLE of the screen that the user is presently accessing. For instance, the TITLE BAR on the Team Set-Up screen could be ‘Team Profile.’

Tool Bar: The Tool Bar is what is displayed either at the top of the screen or at the button, and contains a picture of all of the available ICONS that may be chose to perform certain tasks. Unlike the MENU BAR, the menu bar contains the ‘words’ for functions, whereas the TOOL BAR contains the ‘pictures’ that represent functions.

Tool Buttons: A tool button is ONE of the icons that is shown across the top (or bottom) of a screen on the TOOL BAR.

TPA: Transition Patient Advocates assist in tracking the treatment of seriously ill veterans of Operation Iraqi Freedom (OIF) and Operation Enduring Freedom (OEF).

Uniques: Uniques for the purpose of PCMM Primary Care are defined as the individual veteran (patient) enrolled in VA health care that makes up the primary care provider’s panel.

User Class: User Class is a file that will be transported with the Primary Care Management Module that stores the users (physicians, social workers, staff clerks, etc.) actual position titles as defined by the site.

User Profile: A user profile is called My Profile and is accessed from the left menu bar. It contains user information such as the user’s role.

Vista: Veterans Health Information Systems and Technology Architecture, formerly known as Decentralized Hospital Computer Program, encompasses the complete information environment at VA medical facilities.

VHA: Veteran’s Health Administration

VISN: Veterans Integrated Service Network